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Chapter 1: About Correspondence 
Management

The Correspondence Management Solution Guide provides guidelines to implement correspondence management 

solutions. The guide is intended for the extended project team including solution architects, business analysts, project 

managers, designers, subject matter experts, application specialists, and developers. 

Adobe LiveCycle 

Adobe® LiveCycle® Enterprise Suite 3 (ES3) helps companies rapidly build and deploy applications that enhance 

customer experiences and employee productivity by capturing, visualizing, and exchanging critical business 

information in more compelling ways that increase satisfaction, reduce costs, and create market differentiation.

Correspondence Management Solution

The Correspondence Management Solution centralizes and manages the creation, assembly and delivery of secure, 

personalized, and interactive correspondences. It enables you to quickly assemble correspondence from both pre-

approved and custom-authored content in a streamlined process from creation to archival. As a result, your customers 

get the right communication at the right time in the right way: timely, accurate, convenient, secure, and relevant. Your 

business maximizes the value of customer interactions and minimizes cost and risk with a process that is streamlined 

for ease, speed, and productivity. 

Correspondence Management benefits

The Correspondence Management Solution provides the following benefits:

Efficient and Productive

It streamlines processing, enabling you to:

• Deploy and manage templates and content in an intuitive interface designed for business users

• Quickly assemble correspondence from both pre-approved and custom-authored content

Managed

It provides higher quality communications, enabling you to:

• Manage business rules and approved content in a centralized content repository

• Support simple to complex approval and review processes with a robust BPM engine

• Create Adobe PDF files for archiving and auditing

• Create organizationally compliant messages using preapproved content through embedded business rules.

Extensive

It improves customer engagement, enabling you to:

• Add interactive technologies to enable a two-way channel, reducing paper submissions
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• Protect sensitive information with built-in, end-to-end document security

• Send correspondence via customer’s preferred communication channel, whether electronic, mail, mobile, or fax

Overview of the Solution workflow

The following diagram provides an overview of the correspondence management workflow. The workflow consists of 

three phases:

1 Template creation

2 Correspondence creation

3 Postprocessing

Template creation

The following diagram shows a typical workflow for creating a correspondence template.

Overview of the correspondence template creation process

In this workflow:

1 Form Designers create layouts and fragment layouts using Adobe LiveCycle Designer and upload them to a CRX 

repository. The layouts contain typical form fields, layout features such as a header and footer, and empty "target 

areas" for the placement of content. Later, Application Specialists map the content that is required for these target 

areas. For a description of the Form Designer persona, and other personas, see “Project team” on page 13.
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2 Subject Matter Experts from Legal, Finance, or Marketing departments, create, and upload content such as text 

clauses such as disclaimers, terms and conditions, and images such as logos, that are reused in various 

correspondence templates.

3 Application Specialists create correspondence templates. The Application Specialist:

• Maps text clauses and images to target areas in the layout templates

• Defines conditions/rules for the inclusion of content

• Binds layout fields and variables to underlying data models 

Correspondence creation

There are two ways to generate the correspondence that is sent to your customers: User-driven and System-driven.

User-driven: Customer-facing employees such as claims adjustors or case workers can create customized 

correspondence. Using a simple and intuitive letter-filling interface, business users can add optional text to the 

correspondence, personalize editable content while previewing the correspondence in real time. They can then submit 

the customized correspondence to a back-end process. 

Overview of the user-driven correspondence creation process

System-driven: The correspondence generation is automated, driven by event triggers. For example, a reminder 

notice sent to a citizen prompting him/her for advance tax filing, is generated by merging the predefined template with 

citizen data. The final letter can be emailed, printed, faxed, or archived. 
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Overview of the system-driven correspondence creation process

Postprocessing

The final correspondence can be sent to a back-end process for postprocessing. The correspondence can be: 

• Processed for email, fax, or batch printing, or placed in a folder for printing or e-mailing

• Submitted for review and approval

• Secured by applying digital signatures, certification, encryption, or rights management

• Converted to a searchable PDF document that contains all the necessary metadata for archiving and auditing 

purposes

• Included in a PDF Portfolio that includes additional documents, such as marketing material. The PDF Portfolio 

can then be sent as the final correspondence. 

What’s in the Correspondence Management Solution

The Correspondence Management Solution contains a solution template and three building blocks:
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Contents of the Correspondence Management Solution.

Solution template

The solution template is a reference implementation of the Correspondence Management Solution. 

• The solution template includes representative users and correspondence assets. It provides the following sample 

assets:

• correspondence assets required to create seven letters:

• Welcome Kit

• Policy Jacket

• Endorsement Jacket

• Notice of Cancellation

• Reinstatement Notice

• Claims Coverage Confirmation

• Notice of Subrogation

• two data dictionaries: ProposalEnrollment and PolicySummary

• customer data

• Users with predefined user permissions

• A postprocess to archive the generated correspondence to the file system

For details on how to use the Solution, see “Correspondence Management Solution Walkthrough” on page 33.

Note: The solution template is not supported. It is provided as an example of what you could build using the Solution. 
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Building blocks

The Correspondence Management Solution contains three building blocks:

• Asset Composer building block

• Data Dictionary building block

• Expression Manager building block

Building blocks are product capabilities with clear technical documentation that explains how they can be used for 

production applications. The building blocks are fully supported under the Platinum Enterprise support program. 

Asset Composer building block

The Asset Composer building block provides APIs to create, update, and delete assets and render a document or 

dynamic form based on complex data-driven expressions (rules). The Asset Composer building block also provides 

user interfaces for users to author correspondence assets and to create custom correspondence. The Asset Composer 

building block leverages the Expression Manager building block to evaluate the necessary content (such as text and 

images) required for inclusion or exclusion to generate a personalized correspondence. 

The Asset Composer building block consists of the following user interfaces:

• Editor to create the letter templates

• Editors to create text, lists, nested lists with compound numbering and dynamic lists with repeatable elements

• User interface to upload images

• Editor to create conditions

• Editor to create and customize fragment layouts

• Spell checker (in the text editor)

• Editor to create categories and subcategories

• User interface to upload layouts and fragment layouts

• Create Correspondence user interface, using which business users can create custom correspondence

• Manage Assets user interface, for performing create, update and delete operations on assets

Data Dictionary building block

An important feature of the Correspondence Management Solution is its ability to receive data from a backend data 

source as input for use in a customer correspondence. A data dictionary enables business users to use information from 

backend data sources without knowing technical details about their underlying data models. 

A data dictionary is an independent representation of metadata that describes underlying data structures and their 

associated attributes. A data dictionary is created using business vocabulary. It can be mapped to one or more 

underlying data models.

The Data Dictionary building block consists of the following parts:

• A user interface to create a data dictionary (either manually, or by importing XSD or another compliant data 

model) and to maintain it.

• A server-side component that integrates with backend data sources and instantiates the data dictionary instance

• Data Dictionary Browser user interface component which is used in various editors
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Expression Manager building block

The Expression Manager building block performs computations on data values provided by the Data Dictionary 

building block or by end users.

The Correspondence Management Solution uses the result of the expression evaluation to select assets such as text, 

images, and templates. You can then use the Asset Composer building block to assemble the selected assets into a 

completed correspondence. 

The Expression Manager building block consists of the following parts:

• A server-side expression evaluation module provides the capability to evaluate expressions on the server side

• A client-side expression evaluation module provides the capability to evaluate expressions in a Flex client 

application, without a server roundtrip

• Expression Builder user interface component which is used to create, modify, and delete expressions

Correspondence Management Solution architecture

The following diagram provides an overview of the architecture of the Correspondence Management Solution. 

Correspondence Management Solution architecture.
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Correspondence Management Sample Users

Correspondence Management Solution includes the following sample users who are expected to participate in the 

activities leading to generation of interactive customer communication:

All the user and group information and their relations are captured in a configuration file (template-

correspondencemanagement-pkg) which is read during bootstrap. 

Documentation and resources

The documentation set and associated resources are a guide for planning, installing, developing, and delivering 

Correspondence Management solutions using the Adobe LiveCycle. 

Architects, designers, and developers also have access to a range of support offerings and resources through Adobe and 

its partner community. 

Name Groups Assigned Responsibilities

Todd Goldman 

(tgoldman)

Correspondence Management 

Administrator 

This user is the general system 

administrator. This role enables the user to 

modify all assets. This role also lets define 

the categories. 

Heather Douglas 

(hdouglas)

Correspondence Management Subject 

Matter Expert 

This persona has the role enabling them to 

Create, Retrieve, Update, and Delete texts 

and images

Caleb Lopez 

(clopez)

Correspondence Management Application 

Specialist 

This user defines the letter template by 

judicious usage of the text, picture, 

condition, list objects. With this role, the 

user can Create, Retrieve, Update, and 

Delete the letter templates, layouts, lists, 

conditions, texts, and images 

Gloria Rios (grios) Correspondence Management User A customer interfacing employee such as a 

claims adjuster or case worker who uses the 

letter template defined by the business 

user to produce the letter communication 

to deliver to the customer 

Jocelyn 

Robinson 

(jrobinson)

Correspondence Management Form 

Designer

This user has the skills to design form 

layouts using Adobe® LiveCycle® Designer. 

Having equipped with the necessary know-

how to design form layouts for use in 

correspondence management. This user 

uses Designer, and designs the XDP 

templates, which would serve as the 

boilerplate for the letter. 

Frank Kricfalusi 

(fkricfalusi)

Correspondence Management Developer This user has the knowledge about XSD 

schema and data modeling concepts and is 

responsible for creation and maintenance 

of Data Dictionaries. 
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Resource Audience Description

Solution Guide 

for 

Correspondence 

Management

Solution architects, business 

analysts, project managers, 

designers, application 

specialists, and developers

Introduces the Solution and provides the following information:

• Overview of the Solution 

• Analyzing your current correspondence

• User stories

• Solution walk-through

Installation guide Administrators, developers Describes how to install and configure the Solution.

Developer guide Developers, Administrators Provides technical details on the following information:

• Architecture

• Components of the Solution 

• How to set up your development environment.

• Developer user stories

Building block 

technical guides

Developers Provides technical details about how to implement the building block 

components in your solution. The building block technical guides 

include this information:

• Overview of the building block

• Architecture

• How the building block works

• Detailed descriptions of building block assets such as services, 

processes, tooling, and schemas.

• Implementation details about the user stories

ActionScript® 3.0 

Reference

Developers Contains the ActionScript language elements, core libraries, and 

component packages and classes for the tools, runtimes, services, and 

servers in the Flash® Platform.

API Reference 

(Javdocs)

Developers Describes the Java® API interfaces and classes for the Solutions.

Adobe developer 

connection

Solution architects, business 

analysts, project managers, 

designers, and developers

The LiveCycle Developer Center includes Quick Start content, tutorials, 

videos, downloads, sample, technical guides, blogs, and much more.
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Chapter 2: Analyzing your existing 
correspondence

Before implementing a correspondence management solution, analyze the correspondence that you would like to 

create. This analysis helps you plan the correspondence management solution implementation. 

Deconstructing the correspondence

This Notice of Cancellation document is an example of a typical correspondence:

Notice of cancellation

This correspondence consists of:

• Data that is sourced from backend enterprise systems. The data is merged dynamically with the correspondence 

template.

• Data that can be supplied by a front-line employee who is customizing the letter before sending it out.

• Pre-approved text content. Subject Matter Experts in Legal, Finance, or a line of business who understand the 

business context of the letter, typically author the text content. Content such as header, footer, disclaimers, and 

salutation would be common to most of the letters. However, content such as "reason for termination" would be 

specific to the particular letter.

For some letters, such as a letter to request more information regarding a claim, business users such as the Claims 

Adjustor can add custom text content. 

• Images such as logos and signature images. Images such as corporate logos would appear in most or all of the 

correspondence. Signature images are specific to the letter and to the person on whose behalf the letter is sent.
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Analyze every correspondence to uncover the various pieces that make up the correspondence. The Application 

Specialist analyzes the correspondences that are generated. 

• Which parts of the correspondence are static and which are dynamic. The variables that are filled from backend 

data sources or by end users.

• The order in which the various text paragraphs appear in the correspondence such as whether a business user can 

change paragraphs during correspondence creation.

• Is the correspondence system-generated or does it require an end user to edit the correspondence? How many 

correspondences are system-generated and how many require user intervention? 

• How frequently does the correspondence template change? Will it be updated yearly, quarterly, or only when a 

particular legislation changes? What type of changes are expected? Is it a change to fix typographical errors, a layout 

change, adding more fields, adding more paragraphs, and so on.

When planning your correspondence requirements, assemble the list of new correspondence templates. For each 

correspondence template, you require:

• Text clauses, images, and tables

• Data values from backend systems

• The layout and fragment layouts of the correspondence

• The order in which content appears in the letter and rules for inclusion and exclusion of content

• The conditions under which business users such as claims adjustors or case workers modify content or portions in 

the letter.

Benefits of performing the analysis

Content reuse You will have a consolidated list of new content required for generating correspondence. Much of the 

content such as headers, footers, disclaimers, and introductions are common to many letters and can be reused across 

various letters. All such common content can be created and approved by experts once and then reused in many pieces 

of correspondence. 

Building the data dictionary  There will be data values such as "Customer Id" and "Customer Name" that are common 

to many letters. You can prepare a consolidated list of all such data values. Typically someone from the enterprise 

middleware team is consulted when planning the structure. This forms the basis for building the Data Dictionary.

Sourcing data from backend enterprise systems You will also know all of the data values that are needed and from 

where the enterprise system data is obtained. You can then architect the implementation to extract the data from the 

enterprise system and feed to the correspondence management solution.

Estimating the complexity of letters It is important to determine how complex it will be to create a particular 

correspondence. This analysis helps in determining the amount of time and skill sets that will be required to create the 

letter templates. This in turn will help in estimating the resources and cost of implementing the correspondence 

management solution. 
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Correspondence complexity

The complexity of correspondence can be determined by analyzing the following parameters:

Layout complexity How complex is the layout? Letters such Notice of Cancellation have simple layouts. Whereas 

letters such as Claims Coverage Confirmation has a complex layout with several tables and more than 60 form fields. 

Creating complex layouts takes more time and requires advanced layout design skill sets.

Number of text paragraphs and conditions A loan contract can be 10 pages long and contain more than 40 text 

clauses. Many of these clauses would be dependent on loan parameters. Based on the exact terms and conditions, the 

clauses would be included or excluded from the contract. Creating such letters requires thorough planning and careful 

definition of the complex conditions.

This table provides some guidelines that you can use to classify your letters:

Complexity 

level

Layout complexity 

(subjective)

Number 

of text 

paragrap

hs

Number of 

conditional 

texts or 

images

Required skill set

Low 

complexity

Low. Layout has few 

form fields (<15). 

Typically one page 

long.

8 1 Medium Designer skills.

Medium 

complexity

Medium complexity 

layout. Includes 

structures such as 

tables. Typically more 

than one page long.

16 2 Medium Designer skills.

Capability to create complex 

expressions using user 

interfaces.

High 

complexity

Complex layout. Can 

be greater than three 

pages. Contains 

tables and more than 

60 form fields.

40 8 Expert Designer skills.

Capability to create complex 

expressions using user 

interfaces.
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Chapter 3: Correspondence Management 
scenarios

Scenarios are narratives that describe the user experience, requirements, and benefits of using the Correspondence 

Management Solution. Scenarios also provide:

• The required skill sets and tools you require for your project.

• Best practices for planning your implementation.

• High-level implementation overview.

• A screen shot or illustration when the implementation is provided in the solution template.

Project team

A number of people are involved in creating a correspondence management solution. The Correspondence 

Management Solution includes a solution template. The solution template is a reference implementation of the 

Correspondence Management Solution for a fictitious company. The solution template includes representative users 

for these personas, along with predefined user permissions:

• Form Designer

• Middleware Developer

• Subject Matter Expert (SME)

• Application Specialist

• System Administrator

• Flex Developer

• Customer interfacing employees

Form Designer

Form Designers require knowledge of LiveCycle Designer. The solution template contains a sample Form Designer 

whose name is Jocelyn Robinson. The user ID has been assigned the Correspondence Management Form Designer 

role in Adobe User Management. 

The Form Designer performs the following tasks:

• Uses LiveCycle Designer to create the layouts and form fragments that are used to create letter templates.

Middleware Developer

Middleware Developers have in-depth knowledge of the technology, backend systems, and business processes used by 

the organization. They have the following job background and experience:

• Experience using LiveCycle to integrate into existing enterprise environments

• J2EE application development

• Experience with one or more of the following database servers: MySQL, DB2, SQL Server, Oracle
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• Has developed and deployed enterprise solutions that include: JSP, J2EE, HTML, Web applications, web services

•  Familiar with PDF and Flash® technologies

Tools and technologies used:

• Eclipse, Adobe® LiveCycle® Workbench, XML, XPath, SQL syntax

LiveCycle knowledge and skills:

• Understanding of LiveCycle modules

• Creating and managing applications

• Understanding roles and permissions

• Designing processes

• Interacting with backend systems

• Creating and consuming custom components

• Securing and consuming endpoints

• Monitoring and troubleshooting processes

The solution template contains a sample Middleware Developer whose name is Frank Kricfalusi. The user ID has been 

assigned the Correspondence Developer role in User Management.

The Middleware Developer performs the following tasks:

• Creates the data dictionaries used by the correspondence management system.

• Uses Workbench to create processes (postprocesses) that are triggered when the Claims Adjuster completes a letter.

• Integrates the Create Correspondence user interface with enterprise systems such as portals and case management 

systems.

• Creates workflows to generate system-driven correspondence.

Subject Matter Expert (SME)

SMEs are individuals from departments such as legal, finance, or marketing, who create content such as text and 

images for use in letter templates. They are familiar with the correspondences produced by the organization and they 

create assets related to their fields of expertise.

The solution template contains a sample SME whose name is Heather Douglas. The user ID has been assigned the 

Correspondence Management Subject Matter Expert role in User Management.

The SME performs the following tasks:

• Creates text assets for use in letter templates. 

• Uploads images for use in letter templates

Application Specialist

Application Specialists typically have more technical expertise than the SMEs. They are familiar with the 

correspondences produced by the organization, and the letter template requirements. The Application Specialists 

create complex correspondence assets such as conditions and lists, and combine all of the assets to create letter 

templates.

The solution template contains a sample Application Specialist whose name is Caleb Lopez. The user ID has been 

assigned the Correspondence Management Application Specialist role in User Management.
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The Application Specialist performs the following tasks:

• Creates conditions for use in letter templates.

• Creates lists for use in letter templates

• Combines assets to create letter templates.

For a diagram that illustrates the interaction between the Form Designer, SME, and Application Specialist, see 

“Template creation” on page 2.

System Administrator

System Administrators maintain the servers that LiveCycle and the Correspondence Management Solution run on. 

They install, configure, and monitor the systems. They use CRX to set up users and groups. The system administrator 

is experienced with using CRX User Administration and Group Administration Consoles. 

The solution template contains a sample System Administrator whose name is Todd Goldman. The user ID has been 

assigned the Correspondence Management Administrator role in User Management.

The System Administrator performs the following tasks:

• Sets up users and groups.

Flex Developer

Flex Developers use Flash® Builder™ to modify existing Flex® components included in the Correspondence 

Management Solution, and to create custom components where necessary. They implement styles and themes for all 

existing and custom components to define the visual design. They apply style sheets selectively to certain Flex 

components. They have the following job background and experience:

• Proficient with ActionScript® and MXML

• HTML and CSS knowledge

• Understanding of asynchronous event models

• Experience with backend data integration such as HTTP, Web Services, AMF

• Basic knowledge of J2EE architecture

• Debugging and profiling skills of Flash Player applications

• Experience with Adobe® Flash® Builder

• Understanding of Adobe® Flash® Player security model 

• Knowledge of Adobe runtime environments

• Experience with Adobe data modeling technologies

• Experience integrating with Data Services

Tools and technologies used:

• Eclipse, SQL syntax, HTML, CSS, XML

• Flash Builder

• Data Services

The Flex Developer performs the following tasks:

• Customizes the Manage Assets user interface.

• Customizes the Create Correspondence user interface.
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Customer interfacing employees

Customer interfacing employees use the Create Correspondence user interface to create personalized correspondence 

for customers. 

The solution template contains a sample Customer interfacing employee whose name is Gloria Rios. The user ID has 

been assigned the Correspondence Management Claim Adjustor role in User Management.

The Customer interfacing employee performs the following tasks:

• Creates personalized correspondence for customers.

Scenario: Creating categories and subcategories

Each asset that you create can be tagged with a category and a subcategory. Categories and subcategories enable users 

to focus their searches on assets that fall into a particular category or subcategory. Though the names can indicate 

otherwise, there is no hierarchical relationship between categories and subcategories. 

Create categories and subcategories before creating assets, since one of the steps when creating an asset is to select a 

category and subcategory for it.

Implementation overview

Categories and subcategories provide a way to tag assets. The category and subcategory are related only abstractly, and 

do not provide a way to view assets hierarchically. Once applied to an asset, they facilitate searching and filtering. If 

your organization requires a way to hierarchical view of assets in the Manage Assets user interface, you could use the 

APIs provided with the Correspondence Management Solution to write a customized user interface.

Take time to consider the best way to implement categories and subcategories in your organization. A properly 

designed implementation makes it easier for users to find the assets they require.

As an example, the samples provided in the solution template use the following categorization. 

Tools used

A System Administrator uses the Manage Assets user interface to create categories and subcategories. See “Working 

with categories” on page 75.

Letter Name Category Subcategory

Policy Jacket Policy Administration Policy Issuance

Endorsement Jacket Policy Administration Policy Endorsement

Notice of Cancellation Policy Administration Policy Cancellation

Reinstatement Notice Policy Administration Policy Reinstatement

Claims Coverage Confirmation Claims Claims

Notice of Subrogation Claims Claims



17CORRESPONDENCE MANAGEMENT SOLUTION GUIDE

Correspondence Management scenarios

Last updated 5/12/2013

Category Search

Team members

The System Administrator creates categories and subcategories.

Best practices/tips and tricks

Since categories and subcategories are global, define categories and subcategories that are applicable to all assets.

Scenario: Creating Layouts and Fragment Layouts 

A layout defines the graphical layout of a letter. The layout can contain typical form fields such as “Address” and 

"Reference Number". It also contains empty subforms that denote target areas. 

Create the layout in form designer and when completed the Application Specialist uploads it to the Correspondence 

Management Solution. From there, you can select the layout when creating a correspondence template. Application 

Specialists map content such as text and images into the target areas, and bind form fields to data sources.

Application Specialists can use one layout to create many different correspondence templates. For example, the 

ClaimSubrogation layout shown below contains multiple target areas, some of which can be reused in other letter 

templates:
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ClaimSubrogation Layout

Implementation overview

Follow these steps to set create layouts for the Correspondence Management Solution:

1 Analyze the layout and determine the content that is being repeated across all pages; usually page header and footer 

fit into this category. This content is placed on master pages of layout. The remaining content goes to body pages 

of the layout. In a policy jacket, the logo and company address can be added to master page header and footer. (See 

“Analyzing your existing correspondence” on page 10.) For example, in the solution template, the Notice of 

Reinstatement and Notice of Cancellation both use the same layout. (See “Correspondence Management Solution 

Walkthrough” on page 33.) 

2 When designing body pages, divide page content into sections. Each section is designed as a subform embedded in 

layout itself or as a fragment layout. Use the following guidelines to choose correct approach: 

• If section contains table, model the section as a fragment layout.

3 A Layout can be designed as follows: 

• Make each section as a separate subform containing all elements of the section.

• Make each section subform child of same parent subform. Parent subform's layout are set to flow to allow the 

sections to shift below in case of large data is merged in previous sections.
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• Section Primary residence can be reused across other layouts as well. Create it as a fragment layout.

• Section Additional interest details contains only two elements placed one below another, can contain large data, 

and is designed as flowed.

• Other sections contain elements at specific positions so they are designed as positioned layout. 

• Break a section into subforms if the section contains elements at specific positions, and these elements contain 

large amounts of data. Then arrange the subforms to achieve the desired behavior.

• For Primary residence section, add a placeholder target area. This placeholder is bound to fragment Primary 

residence at the time of letter designing.

4 Upload the layout and fragment layout using Manage Assets user interface.

Tools used

• LiveCycle Designer to create layouts and layout fragments.

• The Manage Assets user interface to upload the layout and layout fragments to the Correspondence Management 

system.

Team members

The Form Designer performs the tasks described in this scenario. The Forms Designer has in-depth knowledge of 

LiveCycle Designer. 

Creating a layout for Correspondence Management

Target version

Use LiveCycle Designer to create layouts, and the layouts must target XFA 2.8 or later. To ensure that your layout is 

using the correct target version:

1 In LiveCycle Designer, click File > Form Properties > Defaults, and set the Target Version to Acrobat/Reader 9.0.

2 Go to the XML Source view and confirm that the template version is 2.8. For example:

<template xmlns="http://www.xfa.org/schema/xfa-template/2.8/">

3 In the template node, search for originalXFA node and if it is present, delete it. For example:

<?originalXFAVersion http://www.xfa.org/schema/xfa-template/2.6/?>

4 Apply any changes to the XML Source by switching to another view.

Creating target area subforms

By default, all subforms that are empty of content are considered target areas. If your layout contains an empty 

subform that is not considered a target area, name the subforms with an "_int" (internal) suffix; for example, 

subformWithScript_int. Use an empty subform as a fragment, containing only a series of script objects that are used 

in various forms. In this case, the subform appears empty, but is not considered a target area. Nodes that are considered 

to be content are: area, draw, exclGroup, exObject, field, subform, and subformSet. 

A target area subform requires the following:

• A name

• A width (non-expandable)
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• A position (x, y)

• Be flowable

A target area subform must not:

• Have a binding (set binding as "none")

• Contain content (child nodes of type area, draw, exclGroup, exObject, field, subform, or subformSet)

• Include an "_int" suffix in its name

• Be on a master page

Using Schema

You can use a schema in a layout or fragment layout, but it is not required. If you use a schema, ensure the following:

• Layout and all the fragment layouts used in a letter use same schema as the letter.

• All fields required to be populated with data are bound to the schema.

Creating relatable fields

By default, all fields are considered relatable to various other data sources. If your layout contains any fields that are 

not relatable to a data source, name the field with an "_int" (internal) suffix; for example, pageCount_int. 

A relatable field must:

• be an XFA <field> or <exclGroup>

• have an XFA binding reference

• if it is an <exclGroup>, it must have at least one child radio button field; otherwise, its value type cannot be 

determined

A relatable field must:

• have a name

A relatable field must not:

• Include an "_int" suffix in its name

• have binding set as "none"

• be a child of an <exclGroup> element

As long as a relatable field meets the criteria described above, it can be in any location and at any nesting depth in the 

layout. You can use relatable fields within master pages.

Fields are more flexible in their layout configuration than target area subforms; however they are tied to a single value 

type. You can make a field large, or set it to a fixed width and height, and so on. The resolved module or rule result is 

pushed into the field. 

Deciding when to use subforms and text fields

Use a subform if you want to capture multiple module content in a top-down vertical-flow layout (multiple paragraphs 

or images). Your layout must handle the fact that the subform grows in height to accommodate its contents. If you 

cannot be certain that the length of the content associated to the subform/target never exceeds the space reserved for 

the subform in the layout, create the subform as a child within a flowed subform container. This process ensures that 

layout objects below the subform flows downward as the subform grows.
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Use a field if you want to capture module data or data dictionary element data into your layout's schema (because fields 

are bound to data) or to display module content on a master page. Remember that content in a master page cannot 

flow with body page content, so you must ensure that the image field used as a header logo. For example, if it is set to 

constrain the image content to its content area, rather than display the image content at its original size. Otherwise, 

for a large image, the image is displayed beneath body page content.

This table provides more criteria for deciding when to use a subform or a field in a layout.

Setting up repetitive elements

When elements such as your organization’s logo and address appear on all pages of a letter, create form fields for those 

elements and place them on the master page. Use Name (Field Name) binding for these fields.

Specify the server render format

Use the layout’s server render format to Dynamic XML Form; otherwise, any letters based on this layout cannot render 

correctly. By default, the server render format in LiveCycle Designer is set to Dynamic XML Form. To ensure that you 

are using the correct format:

❖ In LiveCycle Designer, click File > Form Properties > Defaults, and ensure that the PDF Render/Format setting is 

set to Dynamic XML Form.

Best practices/tips and tricks

Set the default subform binding

When creating target areas in LiveCycle Designer, it helps to set the default binding for all new subforms to "none". To 

set the default binding:

1 In LiveCycle Designer, click Tools > Options > Data Bindings > Subform Binding.

Use a subform when Use a text field when

It contains a combination of elements, 

such as a Last Name and First Name

It contains a single element, such as a Policy Number.

It includes multiple paragraphs Text is wrapped and justified

Repeating, optional, and conditional data 

groups are bound to subforms, to reduce 

the risk of design errors that could occur 

if scripts are used to achieve the same 

results

Elements such as your organization’s logo and address appear on all pages of a 

letter. In this case, create form fields for those elements and place them on the 

master page. If you set the field binding to "No Data Binding", the no fields appear 

as relatable fields in the Letter Editor. If you want to relate some type of content 

to these fields, they must have binding.

If your company address contains more than one line of data, use text field with 

the "Allow Multiple Lines" option to represent the address on the layout.

If a text field's data type is set to plain text, the plain text version of the module 

output is used instead of the rich text version (all formatting is discarded). To 

preserve the formatting, set the text field’s data type to rich text.

Text is flowed Text fields and image fields are used on master pages. Master pages cannot use 

subforms as target areas.

Objects are grouped and organized 

without binding the subform to a data 

element

There is a text field inside the subform. 

The subform can grow and not overwrite 

other objects below it on the layout.

You need easy access to its data in the post process.
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2 In the Default Binding for New Subforms list, select No Data Binding.

This ensures that subforms inserted using the Insert > Subform command or by drag-and-drop from the Object 

Palette has a binding of "none" by default. This means that by default, any new subform is a target area unless you 

add content to it, change its binding setting, or name the subform with an "_int" suffix.

Section 508-compliance

If the finished letter created in the Create Correspondence user interface is used for filling in a later workflow. Follow 

these recommendations related to Section 508 when creating the layout. Otherwise, the letter PDF is for display, and 

you can disregard these recommendations:

• All target area subforms and all fields in a layout have a tab order.

• Fields with captions are 508-compliant by default. The field’s /field/assist/speak@priority attribute is set to 

"custom" by default, which means that, unless custom screen reader text is supplied, the screen reader reads the 

field’s caption.

• Fields without captions specify a tool tip and indicate that screen readers read the tool tip by setting 

/field/assist/speak@priority="toolTip" and specifying tool tip text in /field/assist/toolTip.

Date formats in Designer and Asset Configuration Manager

While designing a layout in LiveCycle Designer, ensure that the formats for date fields match the date formats specified 

in the Asset Configuration Manager. For more information, see “Formatting field values and using patterns” in 

LiveCycle Designer Help.

Capturing date ranges

When dealing with a combination of dates, such as startDate - endDate, use a single subform to ensure correct 

alignment in the finished letter, and to minimize the number of fields.

Setting form-level binding

When a layout contains many fields and target areas that are mapped to single XML elements, use form-level binding 

and create a separate node for each element. Fields that are bound at the form level are ignored when mapping data in 

Correspondence Management.

Do not use subform target areas in a master page

Subform targets areas in a master page are not visible in the Manage Assets user interface and data cannot be mapped 

to them. 

Choosing appropriate positions and types for target areas

When designing the layout, take care when choosing subforms. If the layout contains a single subform, it can be a 

flowed type. After you position fields in the subform, you can wrap it in another subform so that the wrapped subform 

is also flowed and the layout will not be disturbed. 

Placing fields on master pages

Note the following when you place a field on a master page:

• Set the binding of master page fields to Use global data

• Do not place the field directly under the root PageArea of the master page.

• Wrap the field in a named subform and ensure that the binding of the named subform is set to Use name.

http://www.adobe.com/go/learn_lc_designer_10
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Scenario: Creating tables using fragment layouts

Many letter templates contain tables. Tables can be static, such as a table of terms and conditions, where each row 

represents one condition and each part is shown in a separate column. Tables can also be dynamic such as account 

information, which contains information such as customer name, account id, transaction number, and transaction 

amount.

Implementation Overview

Creating static tables using fragments

Tables are sometimes created with rows having a different number of columns. This user story describes how to create 

a table of terms & conditions, where each row represents one condition and each condition can have different subparts. 

Each part is shown in a separate column. 

Implement this scenario by creating three fragment layouts:

1 Fragment layout that contains three rows. Each row has a single column containing a target area which could be 

bound to other fragment layouts. This fragment layout is FLWith3Rows.

2 Fragment layout that contains a single row with two columns. Each column contains a target area. This fragment 

layout is bounded to target areas in first and third row of FLWith3Rows. This fragment layout isFLWith2Cols.

3 Fragment layout that contains a single row with three columns. Each column contains a target area. This fragment 

layout is bounded to target area in second row of FLWith3Rows. This fragment layout is referred as FLWith3Cols.

To create the forms:

1 Open LiveCycle Designer and create a Form. 

2 Add a table containing a single row with only one column. 

3 Add subform to the table column. Ensure that you change the layout of table’s parent subform to flowed and 

remove the bindings of the subform in table. 

4 Save the Form (such as TCMain.xdp). This form is used to create FLWith3Rows.

5 Create a form using LiveCycle designer. 

6 Add a table with single row and single column to this form. 

7 In table creation dialog deselect both header and footer row. 

8 Add a subform to the table cell. Ensure that you change the layout of table’s parent subform to flowed and remove 

the bindings of the subform in table. 

9 Save the Form (such as TCSub.xdp). This form is used to create FLWith2Cols and FLWith3Cols.

Create the fragment layouts, and letter template:

1 Open the Manage Assets user interface and select option to create new fragment layout. 

2 Name this fragment layout FLWith3Rows. Select the form you saved in step 4 for the template. 

3 Select the Table tab and increase the row count to 3. 

4 Save the fragment layout.

5 Create two fragment layouts FLWith2Cols and FLWith3Cols using TCSub.xdp. In FLWith2Cols, in the table 

customization step, increase the column count to 2. In FLWith3Cols, in the table customization step, increase the 

column count to 3. Set the width ratio to 1 for all the columns to provide equal space in row. 
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6 Create a letter template. For main layout, select any layout that contains at least one target area of sufficient size to 

accommodate table.

7 Go to content tab and map fragment layout FLWith3Rows to the target area.

8 There are three targets corresponding to three rows of FLWith3Rows, map FLWith2Cols to the first and third row, 

map FLWith3Cols to the second row.

9 Map new target areas to text modules representing terms and conditions.

10 Create new text modules, if necessary.

11 Save the letter and render it into PDF. At the time of rendering, all the fragments are inserted in the base template.

Creating dynamic tables using fragments

Fragment layouts provide capability of binding a dynamic table's fields to collection DDEs. At the time of letter 

generation table rows are generated according to the size of collection DDEs. This story describes the steps required 

to create a dynamic table using fragment layout. To create a form:

1 From LiveCycle Designer, create a Form. For example, add a table containing a single row with four columns. 

2 Select the Include Header Row in Table option and add fields to all table columns. Ensure following:

• Binding of all the four fields, their container row, and table is set to use name.

• Layout of table’s parent subform is flowed. Set the layout using Subform tab under object properties.

• Table row is repeatable. Go to Binding tab under object properties and select Repeat Row for Each Data Item.

3  Save the form, for example DynamicTable.xdp.

Create fragment layout using this XDP:

1 Name this fragment layout (for example DynamicTable) and select the template you created in the previous 

procedure (for example, DynamicTable.xdp). No customization is required. 

2 Save the fragment layout.

3 Create a Data Dictionary, for example you can create one containing customer name, account id, balance, and 

transaction id. 

4 Create a letter template. For main layout, select any layout that contains at least one target area of sufficient size to 

accommodate table.

5 Select the Data Dictionary you created in step 3. 

6 Go to content tab and map the fragment (such as DynamicTable) to the target area.

7 Go to field map, and map table columns to the DDEs such as customer name, account id, balance, and transaction 

id. These DDEs are collection DDEs (unless there is only a single row) which have multiple values (in the XML used 

for populating values) for each of them. All the table columns are mapped to primitive collection DDEs with same 

parent collection DDE so that they have same cardinality.

8 Save the letter and render it into PDF. At the time of rendering, table rows are repeated depending on the values 

provided in the XML for the collection DDEs.

Tools Used

LiveCycle Designer, Correspondence Management Solution Manage Assets user interface.
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Team Members

A Form Designer designs the forms and an Application Specialist maps new target areas to text modules representing 

terms and conditions

Best Practices

 Keep all container subforms in fragment as flowed to enable customization and resizing of tables. If a fragment 

contains tables, avoid putting target areas and fields at the same level. Tables are resized only if a fragment layout 

contains only tables.

If you are using dynamic tables, set the binding of fields, container row, and table to "use name" for merging data 

correctly with the repeating table.

If you are using dynamic tables, all the repeating DDEs bound to the table fields are part of same hierarchy. All 

collection DDEs fall on the path from root element to the deepest collection DDE. For non-repeating DDEs, there is 

no such restriction.

Scenario: Creating text and images 

Most letter templates include text and images. Images typically include company logos that appear on letters. Text 

includes standard wording and clauses that you want to include on your letters. 

Text assets

A text asset is a piece of content that consists of one or more paragraphs of text. A paragraph can be static or dynamic. 

A dynamic paragraph contains references to data elements, whose values are supplied at runtime. For example, the 

customer name in a letter salutation could be a dynamic data element, with its value made available at runtime. By 

changing these values, the same letter template can be used to generate letters for different customers. 

The Correspondence Management Solution supports two kinds to dynamic data items (variable data):

Data dictionary variables These variables are bound to the data dictionary and get their values from the supplied data 

source. A data dictionary variable can be protected or unprotected. During correspondence creation, the user can 

modify the default value of unprotected data dictionary variables, but cannot modify protected ones.

Placeholders These are variables that are not bound to a backend data source. They require the user to fill in a value 

during correspondence creation. 

Note: The solution template does not force you to create unique names when creating placeholders. If you create two 

placeholders with the same name, such as a text and a condition, and use them both in a  letter template, the values of 

the placeholder last inserted is used for both placeholders. If two placeholders have the same name, their types are 

compared. If the types are different then their type becomes String.

Image assets

An image asset is a graphic that can be used in a letter template. You can upload the following types of images to the 

Correspondence Management Solution:

• JPEG, JPG

• GIF

• PNG
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Implementation overview

A Subject Matter Expert (SME) is responsible for creating the images and text, and having them reviewed and 

approved as required. The SME then uses the Manage Assets user interface and upload assets using corresponding 

editors to upload images and add text to the Correspondence Management Solution Template. For details on how to 

use the Correspondence Management editors to create text and image assets, see “Working with text” on page 50 and 

“Working with images” on page 52.

Tools used

The Manage Assets user interface is used to upload images and create text assets.

Team members

A graphic artist typically creates images. The Subject Matter Expert (SME) uploads the images, and is also responsible 

for creating the text assets, possibly with input from others, such as the legal department. 

Best practices/tips and tricks

• Use a consistent naming convention to avoid duplication.

• Use appropriate data dictionary binding in text modules.

• The following rules apply when using the Text Editor when changing a text asset:

• Addition of variable: Allowed

• Removal of variable: Allowed

• Update of properties: Allowed

• Change of data dictionary: Allowed until data dictionary element is not used. You cannot change the data 

dictionary on update.

• The following rules apply when using the Image Editor when changing to an image:

• Update of properties: Allowed

• Change of data dictionary: Allowed on assigned images. You cannot change the data dictionary on update.

Scenario: Creating conditions and lists 

Conditions enable you to define what content gets included at correspondence creation time, based on the supplied 

data. The condition is described in terms of control variables. The variables can be either a data dictionary element or 

a placeholder. 

Conditions have a single output based on an expression. The first expression is found to be true, based on current 

condition variable. Its value becomes the condition's output. When filling the letter (in Document Composer), 

conditions behave as "white boxes". If a condition results in a list, all of the list's mandatory and pre-selected items are 

output. If any of those items are conditions or lists themselves, their resulting content is output as well, in top-down, 

depth-first order as a flat list of text and image content. Condition results can be of any type (text, image, list, 

condition).
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Lists have multiple output. When filling the letter, individual list items are fully editable (they can be selected, 

deselected, edited, and so on, based on properties set when the list was created in the List Editor). Lists can also be open, 

to permit any extra content from the Library not explicitly assigned to the list when the list was authored in the List 

Editor. Lists basically behave as nestable targets within targets. You can nest lists within lists as well. List items can be 

of any type (text, image, list, condition).

Implementation overview

Implementing conditions

Conditions can be created with control variables. These control variables can be either a custom variable or from the 

data dictionary. 

When you add a condition, you can choose to include an asset based on the value that the control variable has. If the 

control variable can have multiple values, then add as many condition rows as there are possible values. 

The Condition Editor comes with an Expression Builder user interface that supports creating expressions using both 

multiple placeholders and Data Dictionary elements. You can use common operands and local / global functions in 

such expressions. Each expression can be associated with some content and optionally there could be a default section 

if none of the expressions evaluates to true. All expressions are evaluated in the sequence in which they are defined and 

the first expressions returning true is selected and its associated content is returned by that conditional module.

For example, if the terms and conditions text in a letter differs depending which state the customer is in, and the data 

dictionary contains an element called “state”, then you could add the condition as follows:

• state = NY, select T&C_NY text paragraph

• state = NC, select T&C_NC text paragraph

The Condition editor enables you to specify a default condition. If the value of the control variables does not match 

any of the conditions, then the content associated with the default condition is used. Following the previous example, 

you could add this condition row:

• Default, select T&C_Rest

Implementing lists

Implementing lists consists of two steps:

• Defining core properties such as name, description, category, data dictionary, and so on.

• Section of content that is part of the list, and then setting properties such as lock order and library access for the list. 

Protecting and Unprotecting DDEs

Within the Condition Editor, click Add expression to launch the Expression Builder where you can select a Control 

Variable from a data dictionary or create a placeholder. A control variable can be bound to a data dictionary element 

which is protected by default. A control variable bound to data dictionary element or a data dictionary variable, can be 

marked protected or unprotected. To unprotect the variable deselecting the protected selection next to the control 

variable name. When this condition is used inside a letter and rendered during correspondence creation you can only 

modify the default value of unprotected control variables which are bound to data dictionary elements. Protected 

control variables cannot be modified.
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Tools used

List and conditions are created using the Manage Assets user interface. For details, see “Working with lists” on page 54 

and “Working with conditions” on page 52.

Team members

The Application Specialist creates lists and conditions.

Best practices/tips and tricks

• Add the condition prefix to the assets of this type along with the letter name.

• Conditions behave like case statements, so order of condition is important. The first match is returned.

• Use a consistent naming convention to avoid duplication.

• Use appropriate data dictionary binding

• The following rules apply when using the Condition Editor when changing to a condition:

• Addition of variable: Allowed

• Removal of variable: Allowed

• Update of properties: Allowed

• Change of data dictionary: Allowed until data dictionary element is not used. You cannot change the data 

dictionary on update.

• The following rules apply when using the List Editor to when changing to a list:

• Update of properties: Allowed

• Change of data dictionary: Allowed until no item that uses the data dictionary is associated with it. You cannot 

change the data dictionary on update.

Scenario: Creating letter templates

After all of the individual assets (layout, text, images, lists, conditions) have been created for a letter, the Application 

Specialist can combine them into a letter template, which defines the appearance and behavior of the letter.

Common questions to ask to clarify requirements

• Is the data XML in sync with the data model used in the letters?

• Will the letter be system-generated, or can a business user such as a Claims Adjustor create the letter?

• Which parts of the letter is prefilled?

• Which paragraphs in the letter a business user edits, and which are optional?

Implementation overview

The Application Specialist uses the Letter Template Editor in the Manage Assets user interface to create letter 

templates. The Letter Template Editor enables you to: 

• Provide the necessary properties/metadata for the letter template, such as its name and description.
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• Select a layout for the template.

• Select a fragment/table fragment for the target area

• Select a post-process for the letter. 

• Map content to target areas in the layout.

• Map fields and variables in the selected content to data dictionary elements, literals, and so on.

Tools used

The Manage Assets user interface is used to create letter templates. See “Working with letter templates” on page 60.

Team members

The Application Specialist creates letter templates.

Best practices/tips and tricks

• Use a consistent naming convention to avoid duplication.

• Use appropriate data dictionary binding to enable mapping of assets from that data dictionary.

• Bind fields to User when a business user (such as a claims adjustor) generates the letter. For system-generated 

letters, fields do bind to the User.

• For mandatory and fixed content, mark the content as preselected and required.

• Mark content as editable only if it requires the business user (such as a Claims Adjustor) to modify it. 

• Data mapping is set on the Data Map tab in the Letter Template Editor. The following table describes which types 

of data mapping are available for various types of fields. “Yes” indicates that the field type listed in the leftmost 

column supports that type of mapping. “No” indicates that it does not. “N/A” indicates that it is not applicable. 

“TLC” stands for text, list, and condition. “IC” stands for image and condition.

Literal Content Data 

Dictionary

Ignore User Field Variable

date Yes No Yes Yes Yes N/A N/A

time Yes No Yes Yes Yes N/A N/A

datetim

e

Yes No Yes Yes Yes N/A N/A

integer Yes No Yes Yes Yes N/A N/A

float Yes No Yes Yes Yes N/A N/A

richtext Yes TLC Yes Yes Yes N/A N/A

plain 

text

Yes TLC Yes Yes Yes N/A N/A

image No IC No Yes No N/A N/A

signatu

re

No No No Yes No N/A N/A
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Scenario: Creating a Correspondence using the Create 
Correspondence user interface

The Correspondence Management Solution centralizes and manages the creation and delivery of correspondence 

enabling you to quickly assemble correspondence from both preapproved and custom-authored content. The 

Correspondence Management Solution separates document design from content management which means you do 

not need to redesign the document whenever the content changes.

Using the Create Correspondence user interface, you can easily create or modify correspondences for your 

requirements. 

Implementation overview

For instruction on how to use the Create Correspondence user interface to create or modify a correspondence see 

“Correspondence Management Solution Walkthrough” on page 33.

Tools used

• The Create Correspondence user interface to create or modify a correspondence.

• The Manage Assets user interface to modify letter templates and change attributes of content fields in the 

Correspondence Management system.

Team members

Customer interfacing employees such Claims Adjustors, Case Workers perform the tasks described in this scenario. 

Scenario: Moving assets from one system to another

This scenario describes how to export the Correspondence Management Solution assets from the LiveCycle repository 

as a ZIP file and import them into another repository. You can use this procedure to move assets from a development 

environment to a production environment.

Implementation overview

To move an asset, export it from one repository and import it into the new repository. The assets are exported to a .zip 

file, which can then be imported into the new repository.

Export a ZIP file

To export one or more assets from the Correspondence Management Solution repository navigate to the Manage 

Assets user interface, add the assets to an export list and then export the list.

1 Log in to the Manage Assets user interface (http://<server>:port>/lc/content/cm/manageassets.html).

2 Select an asset to export, such as a letter template.

3 Click Add for Export.

A dialog displays the message that the asset is added to the Export List.

The dialog also displays the number of assets currently in the Export List.
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4 After adding all the assets to export to the Export List, click Export assets .

The Export Assets dialog displays the list of assets you selected to export.

You can delete any assets from this list that you do not want to export.

Click Resolve to view all the dependent assets of the assets in the Export List.

5 To export the assets in the Export List click OK.

6 The Export Assets pane prompts you to select a location to download the package. Click OK.

7 Select a folder to save the .zip file containing your assets and then click Save.

Import a ZIP file

To import an asset into the Correspondence Management Solution repository, navigate to the Manage Assets user 

interface and click import.

1 Log in to the Manage Assets user interface (http://<server>:port>/lc/content/cm/manageassets.html).

2 Click Import. Select file to upload window appears. 

3 Navigate to the location of the .zip package containing your assets and click Open.

4 An Import Assets pane appears detailing the list of imported assets, click OK.

Note: The data dictionaries associated with the letter/other assets do not get exported along with them. Export and 

import the data dictionaries for any asset to the new system.

Tools used

The Manage Assets user interface to import and export assets in the Correspondence Management system.

Team members

The Subject Matter Expert performs the tasks described in this scenario. 

Scenario: Viewing dependencies and generating a 
relationship report

This scenario describes how to view asset dependencies, such as which assets include or are included in a particular 

asset. You can generate an XML report detailing the dependences for an asset.

Implementation overview

You can view the dependencies on an asset using the Dependency Browser pane of the Manged Assets user interface.

1 Log in to the Manage Assets user interface (http://<server>:port>/lc/content/cm/manageassets.html).

2 Select the asset to view, such as a letter template.

3 Click Dependencies. A Dependencies Browser pane appears. The left side of the pane details the asset’s attributes 

such as Name, Description, and so on. The right side of the pane contains two tabs, Included In, and Includes. 

4 Click the Included In tab to view the list of assets into which this asset is included.

5 Click the Includes tab to view the list of assets that this asset includes.
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6 Click one of the assets on the right to see the “includes” and “included in” reports for that asset.

7 Click Close.

Generate a relationship report

You can generate a relationship report from the Manage Assets user interface or from within the Dependences 

Browser pane.

1 Log in to the Manage Assets user interface (http://<server>:<port>/content/cm/manageassets.html).

2 Select the asset to view, such as a letter template.

3 Click Report either from the Manage Assets screen or from within the Dependencies Browser Pane.

4 A Letter Template Report pane appears, click OK.

5 The Letter Template Report pane prompts you to select a location to save the report. Select a location and click Save.

Tools used

The Manage Assets user interface to view asset dependencies in the Correspondence Management system.

Team members

The Subject Matter Expert performs the tasks described in this scenario. 
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Chapter 4: Correspondence Management 
Solution Walkthrough

The Correspondence Management Solution separates document design from content management which means you do 

not need to redesign the document whenever the content changes. This structure makes it is easier for creative, 

administrative, and regulatory information to come together, simplifying the management of content across multiple 

departments or product lines. This walkthrough demonstrates how the different personas and roles, within an insurance 

claims processing scenario, can modify and generate the appropriate correspondence appropriate to their role.

This document provides two scenarios for using the Correspondence Management Solution using different user 

credentials. The first scenario guides the Claims Adjustor through the process of modifying an existing 

correspondence and tailoring it to a specific customer using the Create Correspondence user interface. The second 

scenario guides the Correspondence Management Application Specialist through the process of modifying properties 

for content fields within the template using the Manage Assets user interface.

Walkthrough

Create a correspondence

To see how a user with the proper credentials can modify a correspondence, perform the following tasks:

1 Open the Manage Assets user interface. If you have installed the solution and sample users, access it from 

http://<server>:<port>/lc/cm/manageassets.html. Log in using grios as your user name and password as your 

password.

2 In the Manage Assets screen, in the Search box type subrogation and hit enter. 

3 Select ClaimSubrogation and Select Preview > With Test Data. 

4 The Letter Content window opens. There are two views: data and content. If there are no data elements, 

placeholder variables and layout fields, then the letter directly opens in the content view. 
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Claim Subrogation Content

Clicking a content area such as letterDetails, policyDetails expands the content area and reveals all the mandatory 

and optional items associated with that content area. Clicking an item highlights the corresponding content in the 

preview.

5 In the Focus Area pane, select policyConditions, and from the drop-down list click the checkbox next to 

ClaimSubrogation_ConditionForCoverageF. Notice the sentence “Subrogation does not apply to Coverage F or 

Paragraph C. Damage to Property of Others under Section II - Additional Coverages. “ has been added to the 

document. 
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ClaimSubrogation_ConditionForCoverageF

6 In the Focus Area pane, select claimRecovery, then from the drop-down list click the checkbox next to 

ClaimSubrogation_Scenario1ApproxRecovery. Notice the Content Preview/Edit pane now contains a new 

Enter the Amount text field. 

ClaimSubrogation_Scenario1ApproxRecovery

7 In the Content Preview/Edit pane, enter 5977 in the Enter the Amount text field and hit Enter. Notice the 

correspondence has been updated replacing the variable placeholder ${*Amount*} with $5977. 
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Updated Amount in Letter

8 When completed, click Close.

Modify the properties for the Letter Template

To see how a user with the proper credentials can modify the properties of content fields, perform the following tasks:

1 Open the Manage Assets user interface. If you have installed the solution and sample users, access it from 

http://<server>:<port>/lc/cm/manageassets.html . Log in using clopez as your user name and password as your 

password.

2 In the Manage Assets screen, in the Search box type subrogation and hit enter. 

Searching for Subrogation Claim

3 In the Manage Assets window, select Claim Subrogation and click the Edit icon.
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Edit the ClaimSubrogation Letter

4 In the Letter Template Editor, click the Properties icon.
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ClaimSubrogation Letter Properties icon

5 You can change the Description, Category, or Subcategory for the template. Click OK.
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ClaimSubrogation Letter Properties

6 Select a target such as policyConditions. You can now change the properties of your targets. For example, you can 

add or remove items from your Content Library. Policy targets also have conditions that can be changed. When 

the Lock Order button is selected, the order of assets in the target area is locked. 
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ClaimSubrogation Letter Outline Properties

7 Specify the properties of your target using the properties check boxes. Each checkbox corresponds to the icons 

above which are Editable, Required, and Preselected, respectively.

Properties check box icons

When the Editable checkbox is selected, the content can be edited. When the Required checkbox is selected, the 

content is mandatory. When the Preselected checkbox is selected, the content is preselected.

8 Click the Data Editing View selection.
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ClaimSubrogation Letter Data Editing View

9 This pane details how data fields and variables are used in the template. Data can be lined to data sources such as a 

data dictionary or user input. Each field defines properties such as from which data dictionary maps data or what 

caption is displayed for user input fields. 



42CORRESPONDENCE MANAGEMENT SOLUTION GUIDE

Correspondence Management Solution Walkthrough

Last updated 5/12/2013

ClaimSubrogation Letter Data Map

10 Click Done.
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Chapter 5: Using the Correspondence 
Management tools

The Correspondence Management Solution includes several tools for creating, versioning, and publishing assets. 

These tools are broken up into three categories which can be selected from the title bar tabs:

• Manage Assets user interface

• Editors

• Administration tools

Using the Manage Assets user interface

The Manage Assets user interface lists all assets contained within the Correspondence Management implementation. 

Manage Assets user interface

The table contains the list of assets and several associated properties:

• Name: the name of the asset

• Comment: any comment associated to the asset

• Description: the description of the asset

• Updated by: the name of the last person who updated the asset

• Status: an asset’s status is Modified, Ready To Publish and Published

• Version: the version of the asset.

The Manage Assets toolbar contains a list of buttons which perform various tasks related to assets:
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Manage Assets User Interface Toolbar

Creating, editing, and viewing assets

The first icons in the Manage Assets toolbar are used for creating, editing, and viewing assets. The types of assets you 

can create are:

• Text

• Image

• Condition

• List

• Layout

• Fragment Layout

• Letter Template

Creating assets

To create an asset, select the New drop-down list to launch the asset editor appropriate to the asset you are creating.
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Manage Assets New drop down list

Editing asset properties

To edit the properties for any asset, select the asset from the list and click the Edit button. The Editor dialog box for 

that asset is displayed to allow you to change any of the asset’s properties. While you are editing an asset, its status 

changes to Modified.

Changing the data dictionary

When editing an asset, you can change the data dictionary associated with the asset if:

• the asset does not use a data dictionary element

• the same data dictionary is not being used by any of the asset to which it refers

Viewing assets 

To view the properties for any asset, select the asset from the list and click the View button. The Editor dialog box for 

that asset is displayed, but you cannot change any of the asset’s properties.

Viewing asset properties for a previous version

To view the properties for any asset, select the asset from the list and click the View Previous button. The Editor dialog 

box for that asset is displayed, but you cannot change any of the asset’s properties.

Duplicating an asset

To create a copy of an asset, select it and then click the Duplicate icon. A new pane opens to prompt you to enter the 

properties for the new asset. For example, if you copy a letter, the New Letter Template window pane opens requiring 

you to provide a new unique name for the asset.
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Publishing and versioning assets

Each asset has a status of either Modified, Ready to Publish, or Published:

• Modified assets are typically assets that have not been finalized. When you create an asset (including a letter 

template), its status is set to Modified.

• Ready to Publish assets are complete and are ready to be published for use. These assets can be published 

automatically when publishing a dependent asset. An asset is marked as Ready to Publish if you explicitly marked, 

or if the system updates a Published asset.

• Published assets are used in the final correspondence. When publishing an asset, all the assets that use this asset, 

or ones this asset use are scanned to ensure that they are in a Published or Ready To Publish state. All of the assets 

in Ready To Publish state are published automatically. If any asset is in a Modify state, the publish operation is 

aborted. When editing a Published asset it is moved to the Modified state.

Data Dictionaries are not published automatically along with dependent assets. You are required to explicitly publish 

Data Dictionaries separately. When publishing or reverting assets the state of dependent assets, parents and children, 

can cause unexpected results. Here are a few examples:

Note: When publishing a letter, remotely associated assets  are also shown as dependencies. For example, if you create a 

letter with a condition using text assets, then create a second letter that uses the same condition, and finally create a third 

letter that uses the same text assets, when you publish the letter, all letters, text assets, and conditions are listed as 

dependencies. When you mouse over the dependencies their associations are shown.

Action Result

Mark an asset ReadyToPublish and then try to publish 

it.

On publishing a never published asset, only its children are published along with it. If 

the asset has no child asset, it is published successfully.

Reverting an asset with dependencies that has never 

been published

Message is shown that an asset that is never published and has dependencies cannot 

be reverted. Revert operations cannot be performed on never published assets if there 

are dependencies on this asset.

Reverting an asset with no dependencies that has 

never been published

Message is shown that revert operation deletes this asset because it has never been 

published and there is no dependency on it. Upon clicking OK, the asset is deleted.

Mark asset as ready to publish, while some of its 

children are in the Modified state, and then try to 

publish it.

A dialog is displayed with error message that asset cannot be published, because some 

of its children are in Modified state. On publishing a never published asset, all of the 

children are published along with it, which requires that all the children be in Published 

or ReadyToPublish state. 

Mark all children of an asset as ReadyToPublish, and 

Publish the asset.

A dialog is displayed with message that publishing this letter also publishes the 

dependent assets. Upon clicking OK, all the assets are published.

Mark an asset ReadyToPublish and then Publish 

while the parent is in the Modified state.

A dialog is displayed with message that this asset cannot be published because its 

parent is in modified state. When publishing an asset that has been published earlier, 

all the parent and child assets are in ReadyToPublish or Published state.

Republishing an asset whose child asset has another 

parent asset with a different child asset in the 

Modified state.

A dialog is displayed with message that this list cannot be published because an asset 

is in modified state. When publishing an asset that has been published earlier, all the 

parent and child assets along with their dependencies are in ReadyToPublish or 

Published state.

Publish all assets. Modify a child asset to add variable 

(to update all parent asset states to Ready to Publish 

- when editing the parent letter, for example, the new 

variable is visible in the data mapping tab). Revert the 

asset.

A dialog is displayed with message that this operation updates the parent asset. Upon 

clicking OK, the child asset is reverted to its last published version and the new variable 

mapping is removed from the parent asset.
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Template Authors and Employees Interfacing with Customers

There are two users that have distinct roles when performing publishing tasks:

• Template Authors: create Content (such as Text paragraphs, Images, Lists, Conditions, and so on.) and 

Correspondence Templates. The authors typically work using the Manage Assets user interface to Create, Edit and 

Manage assets. They also use the Create Correspondence user interface, for previewing the correspondence 

templates. Content (or Assets) created would lie on this instance until published. Once published, the asset is 

versioned and replicated over to the Publish instance.

• Employees Interfacing with Customers: create/generate the final correspondence, using the available/authored 

templates and content. These employees typically work using the Create Correspondence user interface, to 

interactively generate the final correspondence, based on the defined template. Once the correspondence creation 

is complete, they finish the correspondence by either submitting the same to their end workflow, or saving it as 

draft, or other custom actions that are configured on the application.

Reverting an asset

To revert an asset, select the asset from the list and click the Revert button. The warning message box for that asset is 

displayed, explaining the selected asset reverts to its previously published version. Select OK. You can only revert 

Modified or Ready to Publish assets. Published assets cannot be reverted. 

Note: Reverting an asset that has never been published deletes the asset from the system.

Marking an asset ready to publish

To make an asset ready to publish, select the asset from the list and click the Ready to Publish button. Only assets with 

the Modified status can be made ready to publish.

Publishing an asset

To publish an asset, select the asset from the list and click the Publish button. Only assets with the Ready to Publish 

status can be published.

Deactivating a Letter 

You can deactivate a letter from the Publish Instance.

To deactivate a letter, select a letter on the Author instance that has been published at least once and click Deactivate.

If the letter is in Publish state, it moves to the Ready To Publish state, else the letter remains in its current state in the 

Author instance. The letter on the Publish instance is deleted.

Note: If a published letter has letter Instances in the Draft state, you cannot deactivate the letter.

Data Dictionaries

Data dictionaries are not published automatically when dependent assets are published. You are required to explicitly 

publish data dictionaries.

Moving assets and viewing dependencies

There are situations where it is necessary to move assets from one environment to another, such as migrating from a 

development to a production environment. When moving assets, you must export them from one environment, and 

import them into the new one. For more information, see “Scenario: Moving assets from one system to another” on 

page 30. 
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When an asset is exported, any dependant assets are also exported, you can view asset dependencies and generate XML 

Reports for Letter Templates which list all asset dependencies. For more information, see “Scenario: Viewing 

dependencies and generating a relationship report” on page 31.

Viewing dependencies for an asset

The Dependencies Browser lists all dependencies on an asset. It lists which assets the selected asset is included in, and 

which assets are included with the selected asset. To launch the Dependences Browser, select the asset and click the 

View Dependencies button.

Exporting an asset

You can export assets for use on another server by saving them to a zip archive file. Only Published or Ready to Publish 

assets can be exported. To export an asset, select the asset from the list and click the Export button. The Export Assets 

pane shows the list of dependant assets which is exported with the selected asset. Select the location to store the asset 

and click Save. 

When exporting assets, its related Data Dictionary is not exported automatically. Export the Data Dictionary 

separately because it can refer large number of unrelated assets and can be modified/published separately.

Importing an asset

To import an asset and click the Import button, browse to the location of the .zip archive containing the asset and its 

dependencies and click Open. If an asset exists in the system with the same name, the existing asset is updated. If there 

is no asset, a new asset is created.

Creating a dependencies report for an asset

For Letter Templates you can create a dependencies report listing all assets that the asset is depended on, and which 

assets depend on the selected asset. For assets (Text, Image, Layout, Fragment, Condition, List) the saved data contains 

details of Letters or Assets where it has been used. It has all the Letters and assets (Conditions or Lists) where asset has 

been used in XML format. For Letter the saved data contains details of all Assets used by this letter. To create a report, 

select the Letter Template and click the Make a Report button. Select the location to store the report and click Save

Searching for assets

By default, when you log in to the Manage Assets user interface, the application retrieves all of the assets in the 

currently selected view. You can further refine the search by using the Basic or Advanced search features.

The Basic Search provides full text search on assets. By selecting the Advanced Search, you can filter on specific assets, 

names, descriptions, categories, subcategories, the status, and the person who last updated it. You can use the Basic 

and Advanced searches together to better filter your results. For example, if you search for Notice in a Basic search, 

you can then use the Advanced search to select only Text Modules that contain the text "Notice" text that you specified 

in the Basic Search.

Note: :The search toolbar allows you to search on names and other properties. However, when fields have different data 

and display values, display values cannot be used as search parameters since the search tool only searches data. For 

example, you cannot search on a status such as Modified or Published since these properties are stored as numeric values, 

rather than strings.
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Perform an advanced search

1 Open the Manage Assets user interface. 

If you have installed the solution template and sample users, you can go to 

http://<server>:<port>/lc/cm/manageassets.html. Log in using tgoldman as your user name and password as your 

password.

2 Click the Advanced Search button to display the Advanced Search pod.

Advanced Search

3 Click the Advanced button to display the Advanced Search pod, where you can specify more search criteria. Specify 

the search criteria and click Search.

Advanced Search Pod

Perform a basic search

1 Open the Manage Assets user interface. 

If you have installed the solution template and sample users, you can go to 

http://<server>:<port>/lc/cm/manageassets.html. Log in using tgoldman as your user name and password as your 

password.
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2 Type part of the asset name in the search box and hit enter.

Search Field

Using the Manage Assets Editors

When you create an asset using the New button, or edit an asset, it launches the editor associated to that asset type.

Working with text

For more information on text, including explanations of data dictionary elements and placeholders, see “Scenario: 

Creating text and images” on page 25.

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html. Log in using your appropriate credentials 

(such as user name as tgoldman and password as your password).

2 Click New > Text or select a text asset and click Edit.

3 Specify the following information for the text:

• Name: Type a unique name for the text asset. No two assets (text, image, condition, or list) in any state can exist 

with the same name.

• Description: Type a description of the asset.

• Category: Select a category for the text. The System Administrator defines the categories.

• Subcategory: Select a subcategory for the text. The System Administrator defines the subcategories.

• Data Dictionary: Select the data dictionary in which to map. This attribute enables you to add references to data 

dictionary elements in the text asset.

• Comment: Enter an optional comment. If you are editing an existing asset, you can use this box to indicate the 

reason for the edit.

4 Click OK.

5 A new Text Editor opens, enter the text. The toolbar changes depending on the type of edits you want to make: 

fonts, paragraphs, or bullets:

Font editing toolbar

Paragraph editing toolbar
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Bullet editing toolbar

• To format the text, use the formatting toolbar.

• To add a data dictionary element in the text, select a data element from the list, and click Insert. If you select 

Protected, the data dictionary element is read-only and appears in the letter editor, but not in Create 

Correspondence user interface or Correspondence Creator.

• To add a place holder element in the text, in the Data Elements panel click New. A pop-up note appears to enter 

details for the new Data Element. Click Insert to add the new element to the list. The new place holder can be 

inserted into the text in the same way as data dictionary element.

6 Click Done.

Conditionalizing text

While working with text elements, you can conditionalize inline pieces of text, such that they are displayed only when 

a specified Expression Manager condition is satisfied. You can implement conditions using the {<expression 

@value />} tag, where the @value attribute specifies the expression string. The content wrapped within this tag is 

included in the final resolved content only if the specified expression value evaluates to true.

Follow these steps:

1 In the text editor, select a piece of text—for example, Mr.—and then select Edit > Insert Condition.

2 Specify the condition in the Insert Condition dialog. For example:

{*gender*}=='Male'

Once you enter this condition, the expression for the salutation, Mr., is automatically computed and placed in the 

text element:

{<expression value="{*gender*}=='Male'">Mr.</expression>}

You can test expressions for placeholders/variables (gender in this example) or Data Dictionary elements. An 

example of DDE-based conditions follows:

{^DD_customerDD_customerGender^}=='Male' 

Note: Ensure that string values in expressions are enclosed in single quotes (‘).

3 Click OK.

Additional considerations for inline conditions

Keep the following considerations in mind while working with conditions:

• Inline conditions are not supported for dates.

• Inline conditions are not supported for unprotected collection elements.
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Working with images

For more information on images, see “Scenario: Creating text and images” on page 25.

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html. Log in using your appropriate credentials 

(such as user name as tgoldman and password as your password).

2 Click New > Image or select an image asset and click Edit.

3 Specify the following information for the image:

• Name: Type a unique name for the image asset. No two assets (text, image, condition, or list) in any state can 

exist with the same name.

• Description: Type a description of the asset.

• Category: Select a category for the image. The System Administrator defines the categories.

• Subcategory: Select a subcategory for the image. The System Administrator defines the subcategories.

• Image File: Click the file browser and select the image file to upload.

• Caption: Type a caption of the asset.

• Data Dictionary: Select the data dictionary to which to connect. Only assets that use the same data dictionary 

as the letter, or assets that have no data dictionary assigned, can be selected.  Assigning a data dictionary to an 

image makes it easier for the person creating a letter template to find the appropriate image.

• Comment: Enter an optional comment. If you are editing an existing asset, you can use this box to indicate the 

reason for the edit.

4 Click OK.

Working with conditions

Conditions allow you to choose an item of content based on the value of control variables. 

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html. Log in using your appropriate credentials 

(such as user name as tgoldman and password as your password).

2 Click New > Condition or select a condition asset and click Edit.

3 Specify the following information for the condition:

• Name: Type a unique name for the condition asset. No two assets (text, image, condition, or list) in any state 

can exist with the same name.

• Description: Type a description of the asset.

• Category: Select a category for the condition. The System Administrator defines the categories.

• Subcategory: Select a subcategory for the condition. The System Administrator defines the subcategories.

• Data Dictionary: (Optional) Select the data dictionary to which to connect. Only assets that use the same data 

dictionary as the letter, or assets that have no data dictionary assigned, can be selected.  Assigning a data 

dictionary to a condition makes it easier for the person creating a letter template to find the appropriate 

condition.

• Comment: Enter an optional comment. If you are editing an existing asset, you can use this box to indicate the 

reason for the edit.

4 Click OK.
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5 You can create new assets or select existing ones. The Content Library pane on the right lists all of the existing 

resources available. You can filter the resources you need by selecting the appropriate filter (text, image, list, or 

condition). If no filter is selected, then all resources are displayed. You can also search using the basic and advance 

search features.

Condition Editor

6 To add an asset to the list, select it in the Resource pane and click Insert.

7 The asset is added to the Expression pane.

8 To change the order of the assets within the list, select an asset in the Expression pane and use the arrows to move 

the asset. 

9 You can delete an expression by clicking the delete button.

10 You can edit an expression by clicking the edit button.

11 You can copy an expression by clicking the copy button.

12 You can add expressions by clicking Add Expression to open the Expression Builder. 

Add a new expression

13 In the Expression Builder view, you can create complex expressions. Insert items from the Data Elements view, 

apply operators, and when completed click Validate to ensure that the expression is valid.
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Expression Builder

14 Click OK.

15 Click Done.

You cannot assign a condition to a copy of itself while creating the copy. To handle this, you need to first save the copy 

with a different name and then assign the original condition to the copy.

Working with lists

A list is a group of related content that can be used in a letter template as a single unit. Any kind of content can be 

added to a list. Lists can also be nested. List modules can be specified as:

• ORDERED: The order cannot be changed in the Create Correspondence runtime.

• OPEN: Users can change the order, or add modules to the list

When creating a list, you can specify a type, such as:

• Plain: No additional style formatting is applied to the list.

• Bulleted: A list formatted with a simple bullet.

• Numbered: A numeric list with the choice of Standard (1,2,...), Upper Roman (I, II, ...) and Lower Roman (i, ii,...) 

numerals.

• Lettered: An alphabetical list with the choice of lowercase (a,b,...) and uppercase (A,B,...) letters.

• Custom: You can create any Numbered/Lettered type and prefix and suffix values of your choice.
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Create a list

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html Log in using your appropriate credentials 

(such as user name as tgoldman and password as your password).

2 Click New > List or select a list asset and click Edit.

3 Specify the following information for the list:

• Name: Type a unique name for the list asset. No two assets (text, image, condition, or list) can have the same name.

• Description: Type a description of the asset.

• Category: Select a category for the list. The System Administrator defines the categories.

• Subcategory: Select a subcategory for the list. The System Administrator defines the subcategories.

• Data Dictionary: Select the data dictionary to which to connect. Only assets that use the same data dictionary 

as the letter, or assets that have no data dictionary assigned, can be selected.  Assigning a data dictionary to a list 

makes it easier for the person creating a letter template to find the appropriate list.

• Comment: Enter an optional comment. If you are editing an existing asset, you can use this box to indicate the 

reason for the edit.

4 Click OK.

5 You can create new assets or select existing ones. The Content Library pane on the right lists all of the existing 

resources available. You can filter the resources you need by selecting the appropriate filter (text, image, list, or 

condition). If no filter is selected, then all resources are displayed. You can also search using the basic and advance 

search features.

Sample List of Resources

6 To add an asset to the list, select it in the Resource pane and click Insert.

7 The asset is added to the List Items pane.

8 To change the order of the assets within the list, select an asset in the List Assembly pane and use the arrows to move 

the asset. When the user opens a letter template in the Create Correspondence user interface, the content is 

assembled in the order you defined here.

9 The user can select assets from the Content Library by clicking the Library Access button. 

10 To lock the order of the assets in the list so that the Claims Adjustor cannot change the order, click Lock Order. If 

you do not select this option, the Claims Adjustor can change the order of the list items.
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11 You can select the following options to specify how each asset in the list behaves at runtime:

• Editable: When this option is selected, the content can be edited in Create Correspondence user interface.

• Mandatory: When this option is selected, the content is required in Create Correspondence user interface.

• Preselected: When this option is selected, the content is preselected in Create Correspondence user interface. 

• Skip bullets and numbering: When this option is selected, the content skips bullets and numbering in Create 

Correspondence user interface.

• Indentation: You can change the indentation level of each module/content selected as part of the List. 

Indentation is specified in terms of Levels (starting with zero), such that each level of indent corresponds to a 

padding of 36pts.

• Compound: When selected, the compound numbering is applied as a combination of the outer(parent) List's 

style and it's own style. The compound numbering on this nested List is based on the order in which this nested 

List appears in the outer List.

• Ignore list style: If the Compound Numbering option is deselected, then the option to Ignore List Style is 

enabled. This selection ignores the nested List's own style and the numbering continues from the outer List. 

Therefore the modules of the nested list are treated as part of the outer list itself, disregarding any styles specified 

on the nested List. If the Ignore List Style option is deselected for a nested List, the modules that are part of that 

nested List have their own numbering style. 

To allow the Claims Adjustor to search for and add more content into the list, select the Library Access button. If 

you do not select this option, the Claims Adjustor is limited to the content you have defined for the list.

12 Click Done.

Styling with bullets and indentation in List Modules

The List Module in the Correspondence Management Solution provides the capability to define and group one or 

more Text/Image/Condition/List modules. The set of modules that are selected as part of a List appear in the final PDF 

document in the order in which they are selected in the List. The types of lists you can create are:

• Plain: no style.

• Bulleted: using the bullet character.

• Numbered: using a choice of standard numerals, as well as both uppercase and lowercase roman numerals.

• Lettered: using a choice of both uppercase and lowercase letters.

• Custom: any Numbered/Lettered type and prefix and suffix values.

You can specify indentation on each module/content selected as part of the List (and Target). Indentation is specified 

in terms of Levels (defaults and starts with zero), and each level of indent corresponds to a padding of 36pts.

You can specify an indentation on a nested List module that is selected as part of a target/list. All modules within that 

List are indented to the given level of indentation. If an indent is specified both on the nested list and individual 

modules (within that nested list), then the overall indentation applied on a module would be the indentation on the 

list, plus the indentation on the module.

When including a List within another numbered List, the numbering across the modules of that nested list can be 

specified as compound numbering such as the format 1.1., 1.2.,.. or 1.a., 1.b.,... and so on. If the nested condition does 

not return a list, then the compound numbering selection is ignored. The selection of 'Skip Style', 'Compound 

Numbering' and 'Ignore Style' is dependent on each other. The 'Skip Style' can only be selected when 'Compound 

Numbering' and 'Ignore Style' are deselected. The 'Compound Numbering' can only be selected when 'Skip Style' and 

'Ignore style' are deselected and 'Ignore Style' can only be selected when 'Skip Style' and 'Compound Numbering' are 

deselected. You can ignore the nested list's style and the numbering continues from the outer list as if the modules of 
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the nested list were part of the outer list. If the Ignore List Style option is also deselected for a nested List, the modules 

that are part of that nested List would simply have their own numbering style. The compound numbering on the 

nested list is based on the order where the nested List appears in the outer list. For example, if the nested list appears 

next to a Text Module which is the second Text module in the outer list's selected content, then the numbering applied 

on its module's would be of the form 2.a., 2.b.,... Similar rules apply for other styling combination. When including a 

(nested) 'Plain/Bulleted' List with compound numbering selected, the compound numbering style is applied as per the 

outer list's style. For example, if the outer List has a style of 1, 2, 3.., the numbering on the nested List would be 1.1., 

1.2... If the outer List has a style of A, B, C.. the numbering on the nested List would be A.A.., A.B...., and so on.

Working with layouts

When a layout is complete, you can upload it to the Correspondence Management system so that it can then be used 

to create correspondence templates. The layout is stored in Contentspace. It appears in the Manage Assets user 

interface as a modified asset. Use the Publish icon to publish it before you can use it as a letter template. 

Upload a layout to the Correspondence Management system

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html. Log in using your appropriate credentials 

(such as user name as tgoldman and password as your password).

2 Click New > Layout or select a layout asset and click Edit.

3 Specify the following information for the layout:

• Name: Name that appears in the list in the Manage Assets user interface.

• Description: Description that appears in the list in the Manage Assets user interface.

• Category: Select a category for the layout. The system administrator defines the categories.

• Subcategory: select a subcategory for the layout. The system administrator defines the subcategories.

• Comment: Comment that appears in the list in the Manage Assets user interface.

• Layout: Click the folder icon to browse and select the layout file.

4 Click OK.

Working with fragment layouts

Once a layout is selected for a letter, it is not possible to change components in the layout. This restriction limits their 

reuse and requires the creation of several layouts for letters with only slight differences. However, using fragments 

which are bound to target areas allows the letter to be changed at the time of authoring. Fragments with different 

dimensions can be created and the appropriate fragment can be bound to the target area. Fragment layouts also allow 

you to customize some of the table properties:

1 You can increase the row and column count.

2 You can specify the header and footer text for additional rows and columns.

3 You can define the ratio of table column width. At runtime table columns are resized according to the defined ratio 

and available space.

4 If a table is a place holder (contains only single blank cell), you can define the type (target area/field) of new 

columns.

5 You can hide header and footer rows.
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Before performing this procedure, create an XFA fragment using LiveCycle Designer. The fragment can contain tables 

for organizing fields and target areas. LiveCycle Designer allows creation of two types of tables: static and dynamic. 

Static tables contain a fixed number of rows. Static tables can contain target areas and fields. These target area and 

fields cannot be bound to repeating DDEs. The data bound to table cells determines the number of rows for dynamic 

tables. A dynamic table can contain only fields and these fields can be bound to only DDEs. DDEs can be repeating or 

non-repeating.

Consider the following points when designing tables:

1 Tables can be customized at the time of fragment layout creation. However customize option is enabled only when 

table's parent subform is flowed.

2 For dynamic tables all the fields, repeatable row and table use "use name" binding for data to merge properly.

3 For dynamic tables, all the repeating DDEs bound to the table fields are part of same hierarchy. For non-repeating 

DDEs, there is no such restriction.

4 At the time of merging fragment layout into parent target area tables are resized according to available space, 

however resizing takes place only when fragment layout does not contain any target area or field directly inside top-

level subform. Target area and fields inside table are permitted.

5 You can create place holder tables. Place holder tables have only a single blank cell. For placeholder tables, you can 

customize following properties at the time of fragment creation:

• row count

• column count

• header and footer for each column

• type (target area/field) of each columns

• width ratio for each column

For a non-placeholder table, you can customize following properties:

• row count

• column count

• header and footer for additional column

• width ratio for each column

Upload a fragment layout to the Correspondence Management system

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html Log in using your appropriate credentials 

(such as user name as tgoldman and password as your password).

2 Click New > Fragment Layout or select a fragment layout asset and click Edit.

3 Specify the following information for the layout:

• Name: Name that appears in the list in the Manage Assets user interface.

• Description: Description that appears in the list in the Manage Assets user interface.

• Category: Select a category for the layout. The System Administrator defines the categories.

• Subcategory: select a subcategory for the layout. The System Administrator defines the subcategories.

• Fragment File: Click the folder icon to browse and select the fragment layout file. When assigned to a target area 

in a letter template the fragment layout’s target areas are added to the list of target areas in the left pane of the 

letter editor. 



59CORRESPONDENCE MANAGEMENT SOLUTION GUIDE

Using the Correspondence Management tools

Last updated 5/12/2013

• Comment: Comment that appears in the list in the Manage Assets user interface.

New Fragment Layout Window - General Tab

Note: The table tab is enabled if the Fragment layout contains at least one table and the Fragment layout’s root 

subform is flowed.

4 Click the Table tab and specify the following information for the layout:

• Configuration for: Select the table being configured. If the fragment layout contains single table, the drop-down 

is disabled.

• Static or  Dynamic: This option is enabled only for place holder tables (table containing single cell). For non-

placeholder tables, this field reflects the existing table's type, which cannot be changed. For dynamic tables the 

Columns property is disabled and its value is Field

• Rows: select the number of rows for the layout. The configured row count must be greater than or equal to the 

original row count.

• Columns: select the number of columns for the layout. The configured column count must be greater than or 

equal to the original column count.

• Header and Footer: These check boxes are enabled if existing tables have header/footers. Deselect these check 

boxes to hide header/footer.
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For each column following details are required:

• Header: text to show for the header

• Footer: text to show for the footer

• Type: type of additional column. Field or Target Area. Type is enabled for static place holder tables. Type can 

be defined at column level and not at cell level. All the cells in an extended column would be of the same type. 

For a dynamic table, all the columns are of Field type. For non-placeholder tables, you cannot define the type of 

additional columns. In this case, type of additional cells in extended column is same as the type of last column 

in that row; and type of cell in additional row is same as type of last cell in that column.

• Width ratio: ratio of the table column widths.

5 Click OK.

Working with letter templates

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html. Log in using your appropriate credentials 

(such as user name as tgoldman and password as your password).

2 Click New > Letter Template or select a letter template asset and click Edit.

3 Specify the following information for the letter template:

• Name: type a unique name for the letter template.

• Description: type a description of the letter template.

• Category: Select a category for the letter template. The System Administrator defines the categories.

• Subcategory: select a subcategory for the letter template. The System Administrator defines the subcategories.

• Layout: select the layout for the letter template. 

• Data Dictionary: select the data dictionary to which to connect. Only assets that use the same data dictionary 

as the letter, or assets that have no data dictionary assigned, can be selected. 

• Comment: enter an optional comment. If you are editing an existing asset, you can use this box to indicate the 

reason for the edit.

• Sample Data: Click the open icon to select an XML file containing the sample data which to populate the letter.

• Postprocess: select a postprocess to be applied to the letter template.

Note: if the root node of XML supplied to a letter is substring of the following Strings: xfa, data sets, or data, the PDF 

will not display in Create Correspondence user interface.

4 Click OK.

5 You can create new assets or select existing ones. The Content Library pane lists all of the assets (text, images, lists, 

and conditions) in the system that either use the same data dictionary as the letter template, or have no data 

dictionary assigned to them. You can filter the resources you need by selecting the appropriate filter (text, image, 

list, or condition). If no filter is selected, then all resources are displayed. You can also search using the basic and 

advance search features.
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Sample Content Library

6 To add an asset to the list, select it in the Resource pane and click Insert.

7 The asset is added to the Letter Outline pane.

Letter Outline Pane

8 To change the order of the assets within the list, select an asset in the Letter Outline pane and use the arrows to 

move the asset.

9 You can select the following options to specify how each asset in the list behaves at runtime:

• Editable: When this option is selected, the content can be edited at runtime.

• Required: When this option is selected, the content required at runtime.

• Preselected: When this option is selected, the content is preselected at runtime. 

• Indentation: You can change the indentation level of each module/content selected as part of the List. 

Indentation is specified in terms of Levels (starting with zero), such that each level of indent corresponds to a 

padding of 36pts.

Data Editing View

Data Editing View of a letter displays a list of all the data elements that are coming from the Layout of the Letter (also 

called as Field) or from  the assets included in the Letter (also called as Variable).

Data Editing View
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From this view, you can provide the data link to data elements. The Field elements can be linked to a literal, data 

dictionary element or a user specified value. While the Variable elements can be linked to a literal, data dictionary 

elements, a Field, a Variable, or a user  specified value.

Letter Outline - Data Editing View

Multi-line data entry

Multi-Line

You can specify if the data entry for a field or variable is multi-line. If you select this option, the input box for the field 

or variable displays as mult-line input box in the Data Editing View. The field or variable also displays as multi-line in 

the Data and Content views in the Create Correspondence user interface. The multi-line input field is similar to the 

field for entering a comment in a TextModule.
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Note: The multi-line option is available only for fields and variables with linkage type User or unprotected Data 
Dictionary Elements.

Mandatory / Optional field

Optional field

You can specify if the value for field or variable is optional or mandatory.

Note: The optional field option is available only for fields and variables with linkage type User or unprotected Data 
Dictionary Elements.

Field / Variable Validators

To provide enhanced validation of the value of a field or variable, you can assign a validator to the field or variable.

String Validator Use the String Validator to specify a minimum and maximum length of the string entered in field or 

variable. In addition, you can customize the error message.

When you create a String Validator, ensure that you specify valid validation parameters. You need to enter a valid 

length for both the minimum and maximum values.

Number Validator Use the Number Validator to specify the minimum and maximum numeric value entered in a field 

or variable.

When you create a Number Validator, ensure that you specify valid validation parameters. You need to enter numeric 

values for both the minimum and maximum values.

Regular Expression Validator Use the Regular Expression Validator to define a regular expression that will be used to 

validate the value of a field or variable. In addition, you can customize the error message.

When you create a Regular Expression Validator, ensure that you specify valid regular expression.

Note: The field and variable validators are only available on fields or variables with linkage type User or unprotected 
Data Dictionary Elements.

To use validators in a letter

The SampleLetter contains three elements Name, Age, and Email. In this example, add validators to each of the 

elements.

Name element Assign a string validator to check the name has minimum length 3 characters and maximum length 18 

characters.

1 Go to the Data Editing View for SampleLetter.
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2 Click the Name element.

3 On the right pane, from the Validator drop-down, choose String Validator.

4 Enter 3 and 18 in the Min Length and Max Length fields, respectively.

Age element Assign a number validator to check the minimum age is 18 and maximum age is 60.

1 Go to the Data Editing View for SampleLetter.

2 Click the age element.

3 On the right pane, from the Validator drop-down, choose Number Validator.

4 Enter 18 and 60 in the Min Value and Max Value fields, respectively.

Email element Assign a regular expression validator to check the format of email address.

1 Go to the Data Editing View for SampleLetter.

2 Click the email element.

3 On the right pane, from the Validator drop-down, choose Reg Validator.

4 In the Expression field enter the following reguar expression:

^[a-zA-Z0-9._%+-]+@[a-zA-Z0-9.-]+\.[a-zA-Z]{2,4}$

5 In the No Match Error field, enter Invalid email format..

Click Done to save the changes.

Preview the letter in the Create Correpondence user interface.

In each of the fields, Name, age, and email. Enter values to test validators. For example, enter an invalid email address. 

The Invalid email address message displays below the email field.

Ordering of elements in Create Correspondence interface and Data Editing view

Ordering of elements in the Create Correspondence interface

The variables and fields in the Data view of the Create Correspondence user interface display in the same order as they 

appear in the Letter.

Note: Here it is assumed that the layout is designed in such a way that the hierarchical order of the fields and the target 

areas is the same as their geographical order.

A letter can contain condition modules. Condition modules contain direct variables, derived from expressions, and 

the indirect variables, derived from resultant modules. In the ordering of elements in the Data view, the conditional 

variables display as they appear in the letter. Within the condition, the direct variable display first, sorted 

alphabetically, followed by the indirect variables, in the order as they are assigned in the condition.

Ordering of elements in the Letter editor

In the Data Editing view, the layout fields display first followed by the variables from data modules.

Customizing the order of elements in Create Correspondence interface

The ordering of variables and fields in the Create Correspondence interface can be made similar to their ordering in 

the Data Editing view.

To do this:

1 Go to http://<server>:<port>/lc/system/console/configMgr. And log in with administrator credentials.
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2 Search for Asset Composer Configurations.

3 Then search for Data Elements Ordering.

By default, this option is set to true. This implies that elements in the Create Correspondence interface display in 

the same order as they appear in the Letter.

4 To ensure the elements in the Create Correspondence interface display in the same order as they appear in the Data 

Editing view, set the option to false.

5 Click Save.

Manage attachments

Correspondence Management lets you manage reusable attachments, such as legal documents and annexures, that 

may be associated with one or more letter templates. You can upload an attachment, search for it, update it, or view all 

letter templates with which it is associated.

Upload an attachment

Follow these steps to upload an asset:

1 Click Assets > New > Content.

2 Enter a name and description for the new attachment.

3 Optionally, select a category and subcategory for the attachment.

4 Upload the attachment file in the Content File field.

5 Optionally, enter a caption and comment for the attachment.

6 Click OK.

Associate attachments with a letter template

Using the Manage Assets user interface, you can associate a letter with attachments.

Follow these steps to associate attachments with a letter template:

1 Create a new letter or double-click a letter template in the Manage Assets UI to open it for editing.

2 Select Attachment View from the view drop-down menu.

3 Specify a suitable value in the Max Number of Attachments field.

4 Select one or more available attachments from the Attachment Library in the right pane and click Insert.

5 Mark attachments as Mandatory (*) or Preselected ( ), as necessary.

6 Click the  (Library Access) icon if you want agents to have access to the attachment library at runtime.

7 Click the Lock Order icon if you want to maintain the order of attachments.

8 Click Done.

Manage attachments while previewing the letter

When the agent previews the letter, she can remove the preselected attachments or add new ones, subject to the total 

cap on the number of attachments that can be associated with the letter template.

1 Preview a letter template in the Manage Assets UI.

2 Select Attachment View from the view drop-down menu. 
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3 As necessary, deselect any preselected attachments or select additional attachments from the attachment library. 

The interface indicates how many attachments have been uploaded out of the total limit (for example: 2/4).

You can click the Up and Down arrow icons to change the order of attachments. Click the - icon to delete non-

mandatory attachments, if necessary.

4 Continue performing other operations in the correspondence workflow.

Attachment delivery

• When a completed letter is viewed in the Manage Assets UI in the Letters View, the displayed PDF contains 

attachments as PDF attachments.

• When the Letter is rendered using Server side APIs as an interactive or non-interactive PDF, the rendered PDF 

contains attachments as PDF attachments.

• When a post process associated with a letter template is invoked as part of the Submit or Complete Correspondence 

operations using the Create Correspondence UI, attachments are passed as the List<com.adobe.idp.Document> 

inAttachmentDocs parameter.

• Out-of-the-box delivery mechanisms, such as Email and Print, also deliver attachments along with the PDF of the 

generated correspondence.

Work with letter instances

Correspondence Management lets you efficiently manage letters that have been submitted or saved as draft.

Letter instance management is disabled by default. You can enable this feature for the publish instance by setting the 

Manage Letter Instances configuration parameter to true in the Apache Felix Web console (under Felix 

Configuration > Asset Composer Configurations).

Note: When you create a letter instance on one publish node, it is automatically reverse-replicated on other publish nodes.

The Letter Instance asset type

The Letter Instance asset type has the following metadata associated with it (in addition to standard format attributes 

like PDF File, Processed XDP, and XML Data):

Letter Instance Name This attribute is useful for uniquely identifying a letter instance.

Note: A default name is generated when the agent submits or saves the letter. It is generated from the key elements of a 

DD. In case of no DD or no key elements of DD or no value for the key elements a unique identifier is assigned to the 

instance name. The generated name will have Letter Name as prefix and the key Element Values will be sepearted by '_'. 

This name can be changed in the Properties dialog for the letter instance. On Submit or Save as Draft if the letter instance 

with a same name already exists, user will be prompted with an Alert and on OK the Properties dialog is opened allowing 

the user to change the name and resubmit.

Letter Instance Type An enum with values Complete (for letters saved as draft) or Final(for submitted letters)

Action Log contains information about actions performed on a letter instance. The timestamps for the actions are 

maintained as well.

Letter Name Name of the letter template

Letter Description Description of the letter template

Letter Comment Comments on the letter template

Letter Category Name Name of the category associated with the letter template
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Letter Subcategory Name Name of the subcategory associated with the letter template

Submission Date Date of submission of the letter

Submitted By Name/ID of the agent who submitted the letter

Extended Properties All custom properties associated with letter templates are copied to the letter instance.

Create letter instances

The Create Correspondence UI in the Correspondence Management solution provides the Submit and Save as Draft 

buttons:

Submit The letter (including the PDF file) is saved in the CRX repository as a letter instance object and initiates post-

processing.

Save as Draft The letter (including XML data) is saved in the CRX repository as a letter instance object.

User interface for letter instances

A new Letters tab in the Manage Assets user interface lets you search for and view letter instances. Additionally, this 

tab provides controls to perform the following actions:

• View, Print, and Email complete letters

• View draft letters: Launches the Create Correspondence user interface that lets agents continue working on the 

letter from the point when it was last saved

See the Correspondence Management Solution Guide for more information on creating correspondence.

Controlling page breaks in letters

When you define a letter instance, the letter that is generated may contain sections of text that breaks across pages. For 

example, the letter may contain a paragraph that breaks across two pages.

Correspondence Management includes the Page Break feature that allows you to specify page break settings in a letter, 

at the level of paragraph, text, group of texts, list, or condition. You can use the page break settings to ensure that 

specific part of the letter appear on the same page (do not break across pages).

Note: By default, the page break value is set to true. This implies that the contents will break across pages.

Correspondence Management includes the Page Break Before and Page Break After features that allow you to insert 

manual breaks before and after data modules assigned to a letter.

Set page break at paragraph level

You can set the page break at the paragraph level. If you set the page break attribute of a paragraph to false, the text in 

the paragraph will not break across pages.

1 Open a text module containing the paragraph that you want to ensure does not break across pages.

2 Click inside the paragraph.

The page break attribute for a paragraph is set to true, by default. Notice, the Page Break toggle button  on the 

Paragraph toolbar is selected.

To open the Paragraph toolbar, click the Paragraph button  on the toolbar.

3 Click and deselect the page break button to set the page break attribute to false.

This will cause the paragraph not to break across pages.

Page Break toggle button  on the Paragraph toolbar is unselected.

http://adobe.com/go/learn_dep_correspondence_management_10/
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4 Click Done to save your changes.

5 Add the text module to a letter instance and preview the letter.

The paragraph does not break across pages.

Set page break at text, condition, or list level

You can set the page break at the text module, condition or list asset level. If you set the page break attribute of one of 

the assets to false, the contents of the asset does not break across pages.

1 Open an asset (text module, condition or list).

The page break attribute for an asset is set to true, by default. Notice, the Page Break toggle button  on the 

toolbar is selected.

2 Click and deselect the Page Break toggle button to set the page break attribute to false.

This will cause the contents of the asset not to break across pages.

Page Break toggle button  on the toolbar is unselected.

3 Click Done to save your changes.

4 Add the asset to a letter instance and preview the letter.

The contents of the asset does not break across pages.

Important: If you set the page break attribute of a module to false and the contents of the module is more than one page, 

the contents is truncated. This implies that the contents of the module beyond the page will be lost.

Set the page break for the contents of a list

You can use the Keep With Next feature of a list to set the page break for the assets contained in a list. If you set the 

Keep With Next property of one asset of a list, that asset and the next asset will stay on the same page. This implies that 

the contents of the selected asset and the next asset will not break across pages.

1 Open a list.

Notice the Keep With Next checkbox  to the right of each asset contained in the list.

2 Select the Keep With Next checkbox to the right of one of the assets contained in the list.

This will cause the contents of the selected asset and the following asset not to break across pages.

3 Click Done to save your changes.

4 Add the list to a letter instance and preview the letter.

The contents of the selected asset and the following asset does not break across pages.

The Keep With Next feature should be used in conjunction with the page break feature. If you want to keep the 

contents of two modules together, set the Keep With Next attribute of the first module to true. In addition, it is 

recommented that you set the page break attribute of both the modules to false. If the page break attribute of either of 

the modules is true, that module could break across a page.

Keep With Next in nested lists / conditions

The Keep With Next feature keeps the contents of an entire nested list / condition with the next asset, only if the Page 

Break attribute on the nested list / condition is set to false. However, if the Page Break attribute is set to true, the Keep 

With Next feature keeps the contents of the last asset in the nested list / condition with the next asset.

Say a list, L1, contains a nested list, NL1 followed by a text module TM. NL1 contains two text modules, TM1 and TM2. 

Set the Keep With Next attribute to the list NL1.
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If the Page Break attribute on NL1 is set to true, the Keep With Next feature keeps TM2 and TM together. However, 

if the Page Break attribute on NL1 is set to false, the content of TM1, TM2, and TM does not break across pages.

Note: It is recommended that you use XFA 3.3 and above when using the Keep With Next attribute for lists.

Insert manual page breaks in a letter

You can use the Page Break Before and Page Break After features of a letter to manually insert a page break before or 

after an asset contained within the letter. 

If you set the Page Break Before to true, the page breaks before the module, the contents of this module always displays 

on a new page.

If you set the Page Break After to true for a specific module, the contents of the next module always displays on a new page.

1 Open a letter template in the letter editor or in the Create Correspondence user interface.

Notice the Page Break Before  and Page Break After  checkboxes to the right of each asset contained in 

the letter.

2 Select the Page Break Before checkbox for each asset before which you want to force a page break.

This will cause the contents of the selected asset to always start on a new page.

3 Select the Page Break After checkbox for each asset after which you want to force a page break.

This will cause the contents of the following asset to always start on a new page.

4 Click Done for a letter instance to save your changes. 

The contents of the asset with the Page Break Before set to true displays on a new page. The contents of the asset 

following the asset with Page Break After set to true displays on a new page.

Associate Letter with Post Process

You can associate a letter with a PostProcess while authoring the letter. Some default processes are already provided 

as part of the LCA.

The LCA is packaged with the following out-of-the-box PostProcess solutions that you can associate with a letter.

• Default Print Dispatcher (CorrespondenceManagement/WrapperProcess/DefaultPrintDispatcher)

This process prints the letter and its attachments in Post Script + Simplex mode. The process gets the 

DefaultPrintURL from the SendToPrinter process.

• Default Email Dispatcher (CorrespondenceManagement/WrapperProcess/DefaultEmailDispatcher)

To use this post process, you need to first create a DD and associate the letter with this DD.

The DD must have a DDE with name DeliveryEmailAddress. The sample data must have the email address of the 

user to whom the correspondence is to be mailed.

The other fields of the email are hard-coded in the process to:

Body This is an auto generated email from Correspondence Management. Please do not reply to this email.

Format PDF

Subject Email from Correspondence Management

• Preference Based Dispatcher (CorrespondenceManagement/WrapperProcess/PreferenceBasedDispatcher)

To use this post process, you first need to add a property, deliveryPreference, to the agent user through the User 

Administration tab in CRX. 
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If a user associates a letter with this post process, and you set the deliveryPreference property to Print, the Default 

Print Dispatcher post process is invoked.

However, if you set the deliveryPreference property to Email, the Default Email Dispatcher post process is invoked.

Note: The Email and Print values of the deliveryPreference property are case-sensitive.

To associate a letter with one of these post processes

1 Go to the Letter tab on the Publish instance.

2 Select the letter that you want to associate.

Note: You can only select letters in the Complete state.

3 Choose Custom deliver.

4 In the Send to process dialog, select the process from the drop-down list and click OK.

You can also associate these processes to a letter while you are authroing the letter

1 Open the letter editor to create a new letter or update an exiting letter.

2 In the Post process drop down, select the process and click OK.

3 Render the letter.

4 Submit the letter.

As soon as you submit the letter, the associated post process is invoked.

Deliver completed correspondence

The Correspondence Management solution features out-of-the-box support for the following letter delivery 

mechanisms:

• Email as PDF or HTML

• Print as PostScript (PS) or in the Printer Command Language (PCL)

Each of these actions has an associated out-of-the-box LiveCycle process that is invoked to perform the actual delivery.

In addition to these mechanisms, Correspondence Management provides a custom delivery option that invokes a 

specified LiveCycle process with the correspondence data. Such a custom process lets you perform specific actions on 

the correspondence before delivery and/or enable custom delivery mechanisms, such as fax or SMS.

Delivery workflow

The delivery workflow is triggered after an agent has completed composing a letter. Once the correspondence is 

marked complete (by clicking the Submit button in the Create Correspondence UI), supported delivery mechanisms 

become available on the Letters tab in the Manage Assets UI. These delivery mechanisms become available only for 

letter instances whose status is complete.

All correspondence delivery actions are logged in the audit trail. See Auditing.

Email the completed letter

Note: The email correspondence workflow requires that the LiveCycle Email Service be configured beforehand. See this 

Help topic for more information.

1 Click  on the Letters tab in the Manage Assets UI.

2 In the Email Letter dialog, provide the following details for the email message:

• From, To, CC, and BCC email addresses, as necessary

http://help.adobe.com/en_US/enterpriseplatform/10.0/AdminHelp/WS92d06802c76abadb-4a246f2612905cdf1b0-7fec.html
http://help.adobe.com/en_US/enterpriseplatform/10.0/AdminHelp/WS92d06802c76abadb-4a246f2612905cdf1b0-7fec.html
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Note: You can specify multiple (comma separated) email addresses in the To, CC and BCC fields.

• Optionally, a subject line for the email message

• Optionally, body text that will accompany the correspondence

3 Specify whether you want the correspondence to be emailed as HTML inline in the email or as a PDF attachment.

4 Click OK.

Print the completed correspondence

This action sends the correspondence to the specified printer, which can either be the default printer configured for 

the associated process or a custom printer URL specified by the user. 

1 Click  on the Letters tab in the Manage Assets UI.

2 In the Print Letter dialog, choose either PS (PostScript) or PCL (Printer Command Language) as the Print Format.

When you choose the PS print format, the correspondence attachments are also printed with the correspondence. 

Attachments are not printed for the PCL print format.

3 Choose one of the following print types:

• Simplex

• Duplex Long Edge

• Duplex Short Edge

4 If necessary, specify a custom printer URL. Otherwise, select Use Default to use the default printer configured for 

process associated with the print action.

5 Click OK.

Note: If you are printing correspondence that includes attachments that are either Microsoft Office documents or images, 

ensure that you have PDF Generator module configured.

Note: OMR tags and duplicate print are also supported. The new sample package updates the LayoutGeneric layout that 

contains the duplicate insertion point and OMR capabilities to the layout. So, these capabilities would be available out-

of-the-box for the ‘ReinstantiationNotice’ and ‘NoticeOfCancellation’ Letters.

Configure the default printer URL

1 Navigate to the AdminUI console.

http://<LC server name>:<LC server port>/adminui

2 Go to: Home > Services> Application and Services > Service Management

3 Click CorrespondenceManagement/processes/SavePostProcess : 1.0

4 In the configuration tab, set the defaultPrintURL.

Specify a custom delivery mechanism for the letter

You can choose to send the completed letter to a custom LiveCycle process, so that specific actions can be performed 

on it before delivery. Follow these steps:

1 Click  on the Letters tab in the Manage Assets UI.

2 Select a custom LiveCycle process in the Send To Process dialog box.

3 Click OK.
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(Advanced) Supporting processes

The out-of-the-box correspondence actions are associated with the following processes that perform the actual 

delivery:

• Email:CorrespondenceManagement/processes/EmailPostProcess

• Print: CorrespondenceManagement/processes/PrintPostProcess

Parameters passed to the supporting processes

Email

CorrespondenceManagement/processes/EmailPostProcess takes the following parameters:

format Email format—PDF(1)/HTML(2)

sender Email address from which the email is being sent

toRecipients Recipients in the TO list (comma-separated string)

ccRecipients Recipients in the CC list (comma-separated string)

bccRecipients Recipients in the BCC list (comma-separated string)

subject Subject line of the email message

body Body of the email

Print

CorrespondenceManagement/processes/PrintPostProcess takes the following parameters:

format Print format—PS(4)/PCL(5)

printType Print type—SIMPLEX(1)/DUPLEX LONG EDGE(2)/DUPLEX SHORT EDGE(3)

customPrinterURL If necessary, URL for a custom printer

Access to system context

The new SystemContext system data dictionary gives letters in Correspondence Management access to information 

in the current system context. The system context comprises information about the currently-logged in user and active 

configuration parameters. In particular, the current implementation of the SystemContext DD contains the following 

DDEs:

• agentID

• agentName

• agentFolder

• agentSignatureImage

The new agentSignatureImage DDE is a computed DDE representing the user’s signature image. The expression for 

this computed DDE uses a new custom function exposed by the Expression Manager building block. This custom 

function takes agentID and agentFolder as input parameters and fetches the image content based on these 

parameters.

The value of agentFolder is taken from the CMUserRoot configuration parameter for the Asset Composer 

configuration service. You can change the value of the CMUserRoot configuration parameter using the Felix 

configuration UI. By default this configuration parameter points to /content/cmUserRoot in the CRX repository.

You can override the default custom function to define your own logic for fetching the user signature image.
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Manage user images

The administrator uploads all user signature images at the location to which the CMUserRoot parameter points. Image 

names must be same as the userid of the corresponding users. No file extensions are needed for the image file names.

Correspondence workflow

1 The form designer adds an image field to the appropriate form layouts. These image fields will hold the user 

signature image.

2 At the time of creating a letter, the subject matter expert (SME) selects a form layout that contains an image field 

to display the user signature image.

3 In the Data Editing view, the subject matter expert selects an image field for the signature image. She follows these 

steps:

• Select System from the Linkage Type drop-down menu in the right pane.

• Select the agentSignatureImage DDE from the list in the Data Element panel for the SystemContext DD.

• Save the letter.

4 When the letter is rendered, the agent can see her signature in the image field.

Enter special characters in Correspondence Management asset names

Sometimes, you may want to create Correspondence Management solution assets that contain special characters in 

their names. To do so, you must first define the list of special characters that you want to use in the tbxeditor-config 

XML file.

Follow these steps:

1 Log in to the CRX console at http://<servername>:<port>/crx/de/index.jsp as an admin user. The default 

admin credentials are admin/admin.

2 Edit the content/cm/tbxeditor-config.xml file.

3 Enter the special characters within the customAssetNameCharset tag. For example, to enable the French character 

set, enter the special characters À, Î , Ù, etc within the tag.

4 Save the XML file.

5 Now, to use any character in the Editor Properties dialog, enter Alt + <ASCII value of the special character>.

Administering the solution

The administration tab contains tools for creating and modifying data dictionaries and categories. It also contains a 

utility to export all assets used in the environment.

Working with data dictionaries

A data dictionary is an independent representation of metadata that describes underlying data structures and their 

associated attributes. A data dictionary is created using business vocabulary. It can be mapped to one or more 

underlying data models

The Data Dictionaries editor includes a subset of the tools listed in the Manage Assets toolbar, specifically:

• New
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• Edit

• View

• Revert

• Make ready to publish

• Publish

• Import

• Export

To create a Data Dictionary:

1 Open the Manage Assets user interface. If you have installed the solution template and sample users, you can go to 

the sample portal at http://<server>:<port>/lc/cm/manageassets.html. Log in using tgoldman as your user name 

and password as your password.

2 Click Admin, the click the Dictionary tab, then click New, then select Data Dictionary. The Data Dictionary Editor 

appears.

Data Dictionary Tab

3 In the Properties pane, specify the following information:

• Name: The unique name for the data dictionary.

• Display Name: (Optional) Prepopulated with the text you entered in the Name box. You can change the default 

display name to a more user-friendly display name.

• Description: (Optional) Description of the data dictionary.

• ID: (Optional) A unique identifier that cannot be changed once created.

• Extended Properties: (Optional) Click the plus sign to specify metadata attributes for your data dictionary. In 

the Property Name column, enter a unique property name. In the Value column, enter a value to associate with 

the property.

4 On the Services tab, specify the following information:

Note: The Services tab has not been implemented in this release.

• Service Name: (Optional) The name for the service.

• Display Name: (Optional) The Endpoint.

• Destination: (Optional) The Destination.

• Operation Name: (Optional) The operation name.
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• Operation Properties: (Optional) Click the plus sign to specify operation parameters for your data dictionary. 

In the Name column, enter a unique property name. In the Type column, enter a data type to associate with the 

property. In the Description column, enter a description for this parameter.

5 Click the Definition tab.

6 (Optional) To import an XSD schema definition for your data dictionary, under the Data Dictionary Structure 

pane, click the XSD icon. Browse to XSD file, select it, and click Open.

7 (Optional) You can add element by selecting an option from the New Element list in the Data Dictionary Structure 

pane. Select either Composite Element, Collection Element or Primitive Element. The cursor moves to the Name 

field in the Field and Variable List pane. Enter all of the required properties for the new element. Only the Name, 

Reference Name and Element Type properties are required. You can repeat this step as often as necessary. 

8 (Optional) You can remove any element by selecting it and clicking the Remove Selected Data Dictionary 

Element icon.

9 (Optional) Select an element in the Data Dictionary Structure pane, and in the Field and Variable List panel. 

Change, or add any required attributes associated to the element.

10 Click OK.

Working with categories

Before creating assets, create categories and subcategories that you assign to assets. 

The Categories editor includes a subset of the tools listed in the Manage Assets toolbar, specifically:

• New

• Edit

• View

• Revert

• View Dependencies

To create a Category:

1 Open the Manage Assets user interface. 

If you have installed the solution template and sample users, you can go to the sample portal at 

http://<server>:<port>/lc/cm/manageassets.html. Log in using tgoldman as your user name and password as your 

password, then under Customer Communications click Correspondence Management.

2 Click Admin, and then click Categories.
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Category Tab

3 Click New.

4 In the New Category window, specify the following information for the layout:

• Category Name: Name of the category. The name must be unique, however categories and subcategories can 

have the same name.

• Category Type: Select either Category or Subcategory.

New Category Window

5 Click OK.

Exporting all assets

The Export button, under the Admin and Export tabs, can be used to export all Published or "Ready to Publish" assets 

along with all data dictionaries in single button click. All assets, Letters, data dictionaries which are in Published or 

"Ready to Publish" state are selected for export into a single .zip file archive.
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Export All Assets

Auditing actions

Correspondence Management supports logging of user-triggered or system-triggered actions for auditing purposes. 

Audit trails are secure and accessible only to members of the CM Audit Read group having jcr:read permissions on 

the top-level audit folder.

Logged actions

The following actions are logged as part of audit trails:

• Create an asset

• Update an asset

• Revert an asset

• Read an asset

• Publish an asset

• Save correspondence as draft

• Submit correspondence

• Print final correspondence

• Email final correspondence

• Custom delivery

Once any of these actions are complete, an Audit event is triggered and asynchronously processed to update the logs.

Note: Audit trails related to final correspondence instances are recorded only if correspondence instance management is 

enabled. For more information, see Manage letter instances.

Audit entries capture the following information:

• Asset name



78CORRESPONDENCE MANAGEMENT SOLUTION GUIDE

Using the Correspondence Management tools

Last updated 5/12/2013

• Asset type

• Asset version

• Action by

• Action time

• Action type

• Any other extended properties defined for the asset

Disable auditing

Auditing is enabled by default. You can disable it by modifying the Asset Composer configurations in the Apache Felix 

Web console.

You can disable/enable auditing completely or only for specific actions. For example, to reduce information overload, 

many customers may not want to audit each asset read.

View audit trails

1 Navigate to Admin > Audit in the Correspondence Management solution interface.

2 Select an audit entry and click the  (View the selected asset in read-only mode) icon.

3 Click Close after you’re reviewed the Audit Details.

Audit log locations

By default, audit logs are saved at /content/apps/cm/audit/{yyyy}/{mm}/{dd} in the CRX repository. 

If necessary, you can specify a custom data-splitting custom pattern for the log locations, instead of the default daily 

logging.

Known Issues

Asset search fails if the keyword contains some special characters

Asset search in the Assets view does not return intended results if the keyword contains one of the following special 

characters:

• Whitespace

• Dot ( . )

• Colon ( : )

• Single quote ( ‘ )

• Double quote ( “ )

• Hyphen (- )

• Underscore ( _ )

As a workaround for this issue, use a keyword without these special characters. For example instead of advert_image 

search for advert or image.
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Cursor is lost when you tab out of a conditional variable

In the Create Correspondence user interface, say you enter a value in a conditional variable and press the Tab key. If 

this causes variables to be added or removed, the page in the browser refreshes. Because the page refreshes, the cursor 

does not move to the next field even though you have pressed the Tab key.

To move to the next field, you need to press the Tab key again.

Accessibility shortcuts for Correspondence 
Management tools

Drop-down menus

Text editor

Asset Management UI

Expand Ctrl + Down

Collapse Ctrl + Up

Forward tab from the RichTextEditor to 

the DDE panel

Ctrl+Alt+Tab

Ctrl + Tab

Backward tab from the DDE panel to 

the RichTextEditor

Ctrl+Alt+Shift+Tab

Ctrl + Shift + Tab

Search a DDE from the list in the Data 

Elements panel

Ctrl + Alt +S

Center-align text Ctrl + E

Left-align text Ctrl + L

Right-align text Ctrl + R

Justify text indentation Ctrl + J

Increase the font size Ctrl+Shift+less than sign (<)

Decrease the font size Ctrl+Shift+greater than sign (>)

Undo Ctrl + Z

Redo Ctrl + Y

Bold Ctrl + Alt + B

Italicize Ctrl + Alt + I

Underline Ctrl + Alt + U

New Asset  Ctrl + Alt + N (focus is shifted to the Create New Asset drop down menu)

Edit Asset Enter key
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Deselect a protected checkbox

Follow these steps:

1 Navigate to the DDE and press the F2 key. The focus shifts to the protected checkbox.

2 Press the Space key to select/deselect the checkbox.

Press the Esc key to bring the DDE panel back in focus. 

View Asset Ctrl + V,  Ctrl + Alt + V

Publish History Ctrl + Alt + H

Duplicate  Ctrl + C, Ctrl + Alt +C

Revert To Previously Published Ctrl + Shift + P, Ctrl + Alt + Shift + P

Ready To Publish  Ctrl + Alt + R

Publish  Ctrl + Alt + P

View Dependencies Ctrl + D

Import Package Ctrl + Alt + I 

Export Assets Ctrl + Alt + E

Export Report for Letter Ctrl + Alt + T
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